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Warranty
The media on which you receive National Instruments software are warranted against defects in materials and 
workmanship for a period of 90 days from the date of shipment, as evidenced by receipts or other documentation. N
Instruments will, at its option, repair or replace equipment that proves to be defective during the warranty period.
warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evid
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that 
execute programming instructions if National Instruments receives notice of such defects during the warranty pe
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outs
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping
of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully re
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the 
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader 
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any dam
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL  INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS 
ANY WARRANTY OF MERCHANTABILITY  OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’ S RIGHT TO RECOVER DAMAGES CAUSED 
BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL  INSTRUMENTS SHALL BE LIMITED  TO THE AMOUNT THERETOFORE PAID BY THE 
CUSTOMER. NATIONAL  INSTRUMENTS WILL  NOT BE LIABLE  FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, 
OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of 
National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence.
Any action against National Instruments must be brought within one year after the cause of action accrues. Natio
Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The wa
provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to 
the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product;
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third partie
other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mecha
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, wit
the prior written consent of National Instruments Corporation.

Trademarks
LabVIEW™, natinst.com™, National Instruments™, and NI-VXI™ are trademarks of National Instruments Corpora

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS
National Instruments products are not designed with components and testing intended to ensure a level of reliab
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving m
or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part
user or application designer. Any use or application of National Instruments products for or involving medical or cl
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeg
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should
continue to be used when National Instruments products are being used. National Instruments products are NOT i
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard huma
and safety in medical or clinical treatment.
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The LabVIEW VXI VI Reference Manual describes the VXI virtual 
instruments (VIs) for LabVIEW.

This manual supplements your LabVIEW User Manual, and you should be 
familiar with the material in that manual. You also should be familiar wi
the operation of LabVIEW, your computer, and your computer’s operat
system.

Organization of This Manual
The LabVIEW VXI VI Reference Manual is organized as follows:

• Chapter 1, Introduction, describes how this manual corresponds wit
the NI-VXI Programmer Reference Manual.

• Chapter 2, System Configuration and VXI Library Initialization VIs, 
describes the System Configuration VIs.

• Chapter 3, Word Serial Commander Protocol VIs, describes the VXI 
Word Serial Commander Protocol VIs.

• Chapter 4, Word Serial Servant Protocol VIs, describes the VXI Word 
Serial Servant Protocol VIs.

• Chapter 5, Low-Level VXIbus Access VIs, describes how to use the VIs
that give you the fastest access method for directly reading from o
writing to any of the VXIbus address spaces.

• Chapter 6, High-Level VXIbus Access VIs, describes the VIs with 
which you have direct access to the VXIbus address spaces.

• Chapter 7, Local Resource Access VIs, describes the VIs you use 
to access miscellaneous local resources such as the local CPU V
register set and Slot 0 MODID operations.

• Chapter 8, Shared Memory Access VIs, describes the VIs you use to 
perform shared memory operations.

• Chapter 9, VXI Signal VIs, describes the VIs you use to specify signa
routing, manipulate the global signal queue, and wait for a particu
VXI signal to be received.

• Chapter 10, VXI Interrupt VIs, describes the VIs that control VXI 
interrupts.

• Chapter 11, VXI Trigger VIs, describes the VIs that control triggers, 
backplane feature that VXI adds to the VME standard.
© National Instruments Corporation ix LabVIEW VXI VI Reference Manual
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• Chapter 12, System Interrupt Handler VIs, describes the System 
Interrupt Handler VIs.

• Chapter 13, VXIbus Extender VIs, describes the VXIbus Extender VIs

• Appendix A, Error Codes, describes the error codes returned by 
LabVIEW VXI VIs.

• Appendix B, Customer Communication, contains forms you can use to
request help from National Instruments or to comment on our produ
and manuals.

• The Glossary contains an alphabetical list and description of terms
used in this manual, including abbreviations, acronyms, metric 
prefixes, mnemonics, and symbols. 

Conventions Used in This Manual
The following conventions are used in this manual:

<> Angle brackets enclose the name of a key on the keyboard—for exam
<shift>.

- A hyphen between two or more key names enclosed in angle brackets
denotes that you should simultaneously press the named keys—for 
example, <Control-Alt-Delete>.

» The » symbol leads you through nested menu items and dialog box opt
to a final action. The sequence File»Page Setup»Options»Substitute 
Fonts directs you to pull down the File menu, select the Page Setup item, 
select Options, and finally select the Substitute Fonts options from the 
last dialog box.

This icon to the left of bold italicized text denotes a note, which alerts y
to important information.

bold Bold text denotes the names of menus, menu items, parameters, dialo
boxes, dialog box buttons or options, icons, windows, Windows 95 tab
or LEDs.

bold italic Bold italic text denotes an activity objective, note, caution, or warning.

<control> Key names are lowercase.

italic Italic text denotes variables, emphasis, a cross reference, or an introdu
to a key concept. This font also denotes text from which you supply th
appropriate word or value, as in Windows 3.x.
LabVIEW VXI VI Reference Manual x © National Instruments Corporation
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paths Paths in this manual are denoted using backslashes (\) to separate d
names, directories, folders, and files.

Each VXI VI description in this manual displays an icon before the 
parameter name to designate its data type. These icons are illustrated
defined in the following table. 

Related Documentation
The following documents contain information that you may find helpful 
you read this manual:

• G Programming Reference Manual

• LabVIEW Data Acquisition Basics Manual

• LabVIEW Function and VI Reference Manual

• LabVIEW QuickStart Guide

• LabVIEW Online Reference, available by selecting 
Help»Online Reference

Control Indicator Data Type

Integer

Long Integer

Unsigned Integer 

Unsigned Long Integer 

String

Boolean

Array of Unsigned Long Integer

Array of Unsigned Integer

Array of Unsigned Character

Array of Integer

Array of Boolean

Cluster
© National Instruments Corporation xi LabVIEW VXI VI Reference Manual
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• LabVIEW Online Tutorial (Windows only), which you launch from the 
LabVIEW dialog box

• G Programming Quick Reference Card

• LabVIEW Getting Started Card

• LabVIEW Release Notes

• LabVIEW Upgrade Notes

• The getting started or user manuals for the VXI boards you use

• IEEE Standard for a Versatile Backplane Bus: VMEbus, 
ANSI/IEEE Standard 1014-1987

• VXI-1, VXIbus System Specification, Rev. 1.4, VXIbus Consortium 

• VXI-6, VXIbus Mainframe Extender Specification, Rev. 1.0, VXIbus 
Consortium 

• NI-VXI Programmer Reference Manual 

• NI-VXI User Manual

Customer Communication
National Instruments wants to receive your comments on our products
and manuals. We are interested in the applications you develop with o
products, and we want to help if you have problems with them. To mak
easy for you to contact us, this manual contains comment and configura
forms for you to complete. These forms are in Appendix B, Customer 
Communication, at the end of this manual.
LabVIEW VXI VI Reference Manual xii © National Instruments Corporation
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Introduction

This manual is a companion guide to the NI-VXI Programmer Reference 
Manual that came with your VXI hardware. With the exception of the 
LabVIEW Handler VIs, which correspond to the SetHandler and 
DefaultHandler functions, every VI in this manual corresponds directly
with the function of the same name in the NI-VXI Programmer Reference 
Manual.

National Instruments recommends that you begin by reading the NI-VXI 
User Manual, as well as this chapter, to give you an overview of the VXIb
and NI-VXI. Once you are familiar with this material, you can begin to 
write your program. Notice that the beginning of each function chapter
this book contains a general overview of the operations of the class of
functions in the chapter, as well as a brief description of each function. 
should become familiar with the entire class of functions you are using
that you know which ones are necessary to perform your tasks most 
efficiently.

Refer to the README.TXT file in your NI-VXI directory to obtain the latest 
information about your software, as well as platform specific informatio
regarding your hardware.

VXIbus Overview
This section introduces some of the concepts from the VXIbus 
specification.

VXI Devices
A VXI device has a unique logical address, which you use to find or acc
the device in the VXI system. This logical address can be compared to
GPIB device address. Because VXI uses an 8-bit logical address, you
have up to 256 VXI devices in a VXI system.

Each VXI device must have a specific set of registers, called configuration 
registers. These registers are located in the upper 16 KB of the 64-KB A
VXI address space, as shown in Figure 1-1, VXI Configuration Registers. 
Reference Manual
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The logical address of a VXI device determines the location of the 
configuration registers of the device in the 16-KB area reserved by VX

Figure 1-1.  VXI Configuration Registers

Register-Based Devices
VXI configuration registers, which are required for all VXI devices, hel
the system identify each VXI device, its type, model and manufacturer
address space, and memory requirements. A VXIbus device with only 
minimum level of capability is called a Register-Based device. With this 
common set of configuration registers, the centralized Resource Mana
(RM), which is essentially a software module, can perform automatic 
system and memory configuration when the system is initialized.

Message-Based Devices
In addition to Register-Based devices, the VXIbus specification also 
defines Message-Based devices, which must have communication registers 
in addition to the configuration registers. All Message-Based VXIbus 

Offset

A32 Pointer
A24 Pointer
Data Low
Data High
Response/Data
Extended
Protocol/Signal

12
10
0E
0C

0A

08

Offset
Status/Control
Device Type
ID Register

06
04
02
00

Reserved
Reserved
Reserved
Reserved
Reserved
Reserved

IE
1C
1A
18
16
14

3F

20

Device
Dependent
Registers

Reserved
by VXIbus
Specification

Communication
Registers
Required for VXI
Message-Based
Devices

Configuration
Registers
Required for all
VXI Devices

VXI Configuration
Space

Upper 16 KB of A16
space reserved for
VXI configuration space

64 bytes per device
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base address for
each device

256 devices per
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devices, regardless of the manufacturer, can communicate at a minim
level using the VXI-specified Word Serial Protocol. At this minimum leve
you can establish higher-performance communication channels, such
shared-memory channels to take advantage of the VXIbus bandwidth
capabilities.

Word Serial Protocol
The VXIbus Word Serial Protocol is a standardized message-passing
protocol. This protocol functions much like the IEEE 488 protocol, whic
transfers data messages to and from devices one byte (or word) at a t
Thus, VXI Message-Based devices communicate in a fashion very sim
to IEEE 488 instruments. In general, Message-Based devices typically
contain some level of local intelligence that uses or requires a high leve
communication.

All VXI Message-Based devices must use Word Serial Protocol and 
communicate in a standard way. Use the Word Serial Commander VIs
communicate with message-based devices.

Note In this manual, italics also are used to denote Word Serial commands and quer

Commander/Servant Hierarchies
The VXIbus specification defines a Commander/Servant communicati
protocol so that you can construct hierarchical systems using concept
layers of VXI devices. This structure can be compared to an inverted t
A Commander is any device in the hierarchy with one or more associat
lower level devices, or Servants. A Servant is any device in the subtree of
a Commander. A device can be both a Commander and a Servant in 
multiple-level hierarchy. 

A Commander has exclusive control of the communication registers o
immediate Servants (one or more). Any VXI module has only one 
Commander. Commanders communicate with Servants through the 
communication registers of the Servants using the Word Serial Protoc
Servants communicate with their Commander, responding to the Word
Serial commands and queries from their Commander through the Wor
Serial Protocol. Servants can also communicate asynchronous status
events to their Commander through hardware interrupts, or by writing 
specific signals directly to the Signal register of their Commander.

Although the Word Serial Protocol is reserved for Commander/Servan
communications, two VXI devices can establish peer-to-peer 
© National Instruments Corporation 1-3 LabVIEW VXI VI Reference Manual
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communication through a specified shared-memory protocol or by writ
specific messages directly to the Signal register of the device.

Interrupts and Asynchronous Events
Servants can communicate asynchronous status and events to their 
Commander through hardware interrupts or by writing specific messag
(signals) directly to the hardware Signal register of their Commander. 
Devices that are not bus masters always transmit such information thro
interrupts, whereas devices that have bus master capability either can
interrupts or send signals. Some devices can receive only signals, but o
might be only interrupt handlers.

The VXIbus specification defines Word Serial commands so that a 
Commander can understand the capabilities of its Servants and config
them to generate interrupts or signals in a particular way. For example
Commander can instruct its Servants to use a particular interrupt line, s
signals rather than generate interrupts, or configure the reporting of on
certain status or error conditions.

VXI Handler VIs Overview
A VXI handler is a user routine that is executed when some event occu
the VXI interface. For example, you can set a VXI interrupt handler to 
execute when an interrupt is asserted.

You can use VXI VIs to create a handler as part of your LabVIEW diagra
The handler can use any LabVIEW VI, including other VXI VIs. The VI
you use to create these handlers are called the Handler VIs.

The Handler VIs are analogous to the SetHandler and DefaultHandler c
in the NI-VXI Programmer Reference Manual. The inputs to the Handler 
VIs are the same as the parameters to the SetHandler functions. The ou
to the Handler VIs are the same as the parameters to the DefaultHand
functions.

The Handler VIs are implemented using LabVIEW occurrences. Beca
an occurrence is a one-shot event (the dependent VIs are executed only 
once), you must put the Handler VI and your handler in a while loop 
structure.

Figure 1-2, Example of an Interrupt Handler, shows an example of a 
LabVIEW interrupt handler, which displays the dialog box whenever a
LabVIEW VXI VI Reference Manual 1-4 © National Instruments Corporation
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interrupt of a certain level is asserted. The VXI VIs store the pending 
interrupts so that the handler executes once for each handler.

Figure 1-2.  Example of an Interrupt Handler

Passing the value 3 to a Set Handler VI tells the VXI VI library to begin 
queueing occurrences for later handling by a Handler VI.

Note Even on platforms where VXI user handlers normally are executed at interrupt
time (such as Macintosh and Windows), the LabVIEW user handler diagram is
not executed at interrupt time.

VXI VI Library Overview
The NI-VXI Programmer Reference Manual gives explanations of the 
NI-VXI functions. The material found in that manual applies equally to t
NI-VXI LabVIEW VXI VIs, and you can use it as a reference in 
conjunction with this document. The VIs are divided into the following 
groups:

• System Configuration VIs initialize the NI-VXI interface at the lowest 
level. In addition, the System Configuration VIs can retrieve or mod
device configuration information. 

• Word Serial Commander Protocol VIs are used by Word Serial 
Commanders to communicate with a Message-Based Servant dev
using the Word Serial, Longword Serial, or Extended Longword Se
protocols. Word Serial is the minimal mode of communication 
between VXI Message-Based devices. These VIs can perform 
command/query sending and buffer reads/writes.
© National Instruments Corporation 1-5 LabVIEW VXI VI Reference Manual
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• Word Serial Servant Protocol VIs give Message-Based Servant 
devices all of the necessary capabilities to communicate with the 
Message-Based Commander of the local CPU (the device on which
NI-VXI interface resides) using the Word Serial, Longword Serial, 
Extended Longword Serial protocols. These capabilities include 
command/query handling and buffer read/writes.

• Low-Level VXIbus Access VIs offer the fastest access method for 
directly reading from or writing to any of the VXIbus address space
Use them when execution speed is critical.

• High-Level VXIbus Access VIs are similar to the Low-Level VXIbus 
Access VIs, but these VIs give you direct access to the VXIbus add
spaces. You can use these VIs to read, write, and move blocks of 
between any of the VXIbus address spaces. You can specify any 
VXIbus privilege mode or byte order. The VIs trap and report Bus 
Errors. The High-Level VXIbus Access VIs are easy-to-use. You 
should use them when execution speed is not crucial.

• Local Resource Access VIs offer access to miscellaneous local 
resources such as the VXI register set of local CPU, Slot 0 MODID
operations (when the local device is configured for Slot 0 operatio
and the VXI shared RAM of the local CPU. These VIs are useful f
shared memory type communication, for non-Resource Manager 
operation (when the local CPU is not the Resource Manager), and
debugging purposes.

• Shared Memory Access VIs offer access to local CPU-shared RAM.

• VXI Signal VIs are used by VXI bus masters to interrupt another 
device. The value written to a Signal register of a device has the s
format as the status/ID value returned during a VXI interrupt 
acknowledge cycle. You can route VXI signals to the default interru
service routine or place them into a global signal queue. VXI signa
VIs can specify the signal routing, manipulate the global signal que
and wait for a particular signal value (or set of values) to be receiv

• VXI Interrupt VIs let you process individual VXI interrupt status/IDs
as VME status/IDs, VXI status/IDs, or VXI signals. By default, 
status/IDs are processed as VXI signals. VXI interrupt VIs can spec
the status/ID processing method and can assert specified VXI inter
lines with a specified status/ID value.

• VXI Trigger VIs are a standard interface to source and accept any
the VXIbus TTL or ECL trigger lines. These VIs can also detect 
acknowledgements from the accepting device and send the 
acknowledgements back to the sourcing device. You can use these
as configuration tools for signal conditioning and routing trigger line
LabVIEW VXI VI Reference Manual 1-6 © National Instruments Corporation



Chapter 1 Introduction

ell 
nd 
; 

, 

rs 

 in a 

m: 

 
.

 

and for configuring the settings of the trigger inputs and outputs as w
as the National Instruments Trigger Interface Chip (TIC) counter a
tick timers. VXI trigger VIs support all VXI-defined trigger protocols
the actual capabilities depend on the specific hardware platform.

• System Interrupt Handler VIs let you handle the system interrupt 
conditions. These conditions include Sysfail, ACfail, Sysreset, 
BusError, and SoftReset interrupts.

• VXIbus Extender VIs allow you to dynamically reconfigure 
multiple-mainframe transparent mapping of the VXI interrupt lines
TTL triggers, ECL triggers, and utility bus signals. The National 
Instruments Resource Manager configures the mainframe extende
with settings based on user-modifiable configuration files.

LabVIEW 5.0 includes new VXI VI examples. See these examples in 
\labview\examples\instr\smplvxi.llb

Multiple Mainframe Support
The NI-VXI functions described in this manual support multiple 
mainframes both in external CPU configurations and embedded CPU 
configurations. The Startup Resource Manager supports one or more 
mainframe extenders and configures a single- or multiple-mainframe 
VXI/VME system. Refer to the VXIbus Mainframe Extender Specification, 
Revision 1.3 or later, for more details on multiple mainframe systems.

Controllers
A controller is a device that is capable of controlling other devices. A 
desktop computer with a MXI interface board, an embedded computer
VXI/VME chassis, a VXI-MXI, and a VME-MXI may all be controllers 
depending on the configuration of the system.

There are several types of controllers that may exist in a VXI/VME syste
embedded, external, and remote.

• embedded controller—A computer plugged directly into the 
VXI/VME backplane. An example is the National Instruments 
VXIpc-850. All of the required VXI/VME interface capabilities are 
built directly onto the computer itself. An embedded computer has
direct access to the VXI/VMEbus backplane in which it is installed

• remote controller—A device in the VXI/VME system that has the 
capability to control the VXI/VMEbus, but has no intelligent CPU 
installed. An example is the VXI-MXI-2. In NI-VXI, the parent-side
© National Instruments Corporation 1-7 LabVIEW VXI VI Reference Manual
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VXI-MXI-2 (that is, the VXI-MXI-2 with a MXI-2 cable connected 
towards the root frame) in the frame acts as a remote controller. A
embedded or external controller may use a remote controller to con
the remote mainframe.

• external controller—A desktop computer or workstation connected 
the VXI/VME system via a MXI interface board. An example is a 
standard personal computer with a PCI-MXI-2 installed.

In general, a multiple mainframe VXI/VME system will have one of the
following controller configurations:

• An embedded controller in one frame that is connected to other fram
via mainframe extenders using MXI-2. VXI-MXI-2 or VME-MXI-2 
boards in the other frames can also be used as remote controllers
Figure 1-3.

Figure 1-3.  An Embedded Controller Connected to Other Frames via Mainframe 
Extenders Using MXI-2

• An external controller connected using MXI-2 to a number of remo
controllers, each in a separate frame. The external controller can 
the remote controllers for control of the VXI/VME system, or it can
use its own controller capabilities. See Figure 1-4, An External 
Controller Connected Using MXI-2 to a Number of Remote 
Controllers.
LabVIEW VXI VI Reference Manual 1-8 © National Instruments Corporation
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Figure 1-4.  An External Controller Connected Using MXI-2 to a Number of Remote 
Controllers

The Extender and Controller Parameters
In NI-VXI, some functions require a parameter named extender or 
controller . Since some extenders act as controllers, there is often confu
concerning what logical addresses should be passed to these function

The extender parameter is the logical address of a mainframe extender
which the function should be performed. Usually, functions with an 
extender parameter involve the mapping of interrupt lines or trigger line
into or out of a frame. The controller parameter is the logical address of a
embedded, external, extending, or remote controller. Usually, function
with a controller parameter involve sourcing or sensing particular 
interrupts or triggers in a frame. According to the definitions of the 
different types of controllers, the only valid logical addresses for the 
controller parameter are:

• The external or embedded controller on which the program is runn

• A parent-side VXI-MXI-2 or VME-MXI-2 in a frame.
© National Instruments Corporation 1-9 LabVIEW VXI VI Reference Manual
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Most functions that take a controller parameter will allow you to pass (–1)
as the logical address. This selects the default controller for the system
Notice that the default controller is determined by the following factors

• If the program is running on an embedded controller, the default 
controller is the embedded controller.

• If the program is running on an external controller, you can configu
whether the default controller is the external controller or the remo
controller with the lowest numbered logical address. With this 
behavior, if you write a program on an embedded controller referri
to the controller as logical address –1, you can swap the embedde
controller configuration with an external controller configuration 
without changing your source code.

Notice that –1 is never a valid value for the extender parameter. In addition, 
the logical addresses of embedded and external controllers also are n
valid values for the extender parameter. The extender parameter refers 
only to devices that can map interrupt lines, trigger lines, or other sign
into or out of a frame.

Error Handling Parameter
Each of the NI-VXI VIs contains error in and error out clusters that kee
track of error information as the VIs execute. If the error in cluster pas
to a VI already contains an error the VI will not execute. Instead it will on
pass on the same error information. Otherwise, it will execute and pass
status of its execution out the error out terminal. More information on t
error codes used by the VIs and how they relate to the status codes us
older versions of the NI-VXI VIs can be found in Appendix A, Error 
Codes.

Converting Old Applications

Existing programs automatically load the previous versions of the NI-V
VIs. These VIs have the word “Old” on the icon and have _old added to 
their names to distinguish them from the new VIs. The new NI-VXI VIs a
supported only in LabVIEW 5.0 and later. You can combine Old and n
VIs when you convert or add on to existing applications. However, only
the new VIs use error clusters. The Old VIs are located in 
\labview\Vi.lib\Instr\VXI\old . 
LabVIEW VXI VI Reference Manual 1-10 © National Instruments Corporation
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System Configuration and VXI 
Library Initialization VIs

This chapter describes the System Configuration VIs. Your application
program can use these VIs to copy all of the Resource Manager (RM) t
information into data structures at startup so that you can find device na
or logical addresses by specifying certain attributes of the device for 
identification purposes.

Locating System Configuration VIs in LabVIEW
Select Windows»Show Diagram to go to the block diagram in LabVIEW.
From the Functions palette, choose Instrument I/O»VXI»System 
Configuration  to locate the System Configuration VIs in LabVIEW.

Finding Help Online for System Configuration VIs
You can find helpful information about individual VIs online by using th
LabVIEW Help window. Open the Help window by choosing Help»Show 
Help in LabVIEW. When you place the cursor on a VI icon, the wiring 
diagram and parameter names for that VI appear in the Help window.

You also can double-click the VI to open the front panel. When the He
window is open, you can get more information on each parameter by 
placing the cursor over the corresponding control or indicator on the V
front panel.

Handling Errors
The NI-VXI VIs use the LabVIEW error cluster method for handling 
errors. Each VI has error in and error out terminals. See Appendix A, Error 
Codes, for information on how the error codes relate to the previous sta
codes used by the NI-VXI VIs and a description of error in  and error out  
parameters.
Reference Manual
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System Configuration VI Descriptions

CloseVXIlibrary
Disables interrupts and frees dynamic memory allocated for the internal device informa
table. You should call this VI before exiting your application.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

CreateDevInfo
Allocates space in the device information table for a new entry with logical address la. 
The fields in the device information table for the entry are set to default values (null or 
unasserted values).

la is the logical address of the device for which to create an entry in th
device information table.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.
LabVIEW VXI VI Reference Manual 2-2 © National Instruments Corporation



Chapter 2 System Configuration and VXI Library Initialization VIs

, you 

wo 

, for 

r.

ee 
FindDevLA
Finds a VXI device with the specified attributes in the RM table and returns its logical 
address. You can use any combination of attributes to specify a device. In this manner
can acquire unknown device names or logical addresses. If namepat is “”  or any other 
attribute is –1, or not connected, that attribute is not used in the matching algorithm. If t
or more devices match, la contains the logical address of the first device found.

mainframe is the mainframe location of the device (logical address of 
mainframe extender).

devclass is the device class of the device. 
0: Memory Class Device.
1: Extended Class Device.
2: Message-Based Device.
3: Register-Based Device.

namepat is the name pattern. A partial name is acceptable (for example
GPIB-VXI, it will accept GP).

manid is the VXI manufacturer identification number.

modelcode is the 12-bit or 16-bit model number of the VXI manufacture

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

slot is the slot location of the device.

cmdrla is the logical address of the Commander.

la is the logical address of the device found.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.
© National Instruments Corporation 2-3 LabVIEW VXI VI Reference Manual
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GetDevInfoLong
Gets information about a specified device from the device information table. The informa
is contained in a 32-bit unsigned integer.

la is the logical address of the device to get information about.

field is the field identification number.
12: Base of A24/A32 memory.
13: Size of A24/A32 memory.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

longvalue is the information for that field.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

GetDevInfoShort
Gets information about a specified device from the device information table. The informa
is contained in a 16-bit unsigned integer.

la is the logical address of the device to get information about.

field is the field identification number.
2: Logical address of the Commander.
3: Mainframe.
4: Slot.
5: Manufacturer identification number.
7: Model code.
9: Device class.

10: Extended subclass (if extended class device).
11: Address space used.
14: Memory type and access time.
LabVIEW VXI VI Reference Manual 2-4 © National Instruments Corporation
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ee 
15: Bit vector list of VXI interrupter lines.
16: Bit vector list of VXI interrupt handler lines.
17: Mainframe extender, controller information.

 

18:  Asynchronous mode control state.
19:  Response enable state.
20:  Protocols supported.
21:  Capability/status flags.
22:  Status state (Pass/Fail, Ready/Not Ready).

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

shortvalue is the information for that field.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

Bits Description

15 and 14 Reserved

13 1: Remote controller
0: Not remote controller

12 1: Child side extender
0: Parent side extender

11 1: Frame extender
0: Not frame extender

10 1: Extended controller

9 1: Embedded controller

8 1: External controller

7 to 0 Frame extender towards root frame
© National Instruments Corporation 2-5 LabVIEW VXI VI Reference Manual
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GetDevInfoStr
Gets information about a specified device from the device information table. The informa
is contained in stringvalue.

la is the logical address of the device to get information about.

field is the field identification number.
1:  Device name.
6:  Manufacturer name.
8:  Model name.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

stringvalue is the information for that field.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

InitVXIlibrary
Allocates and initializes the data structures required by the VXI library VIs in the driver. T
VI reads the RM table file and copies all of the RM information into data structures in lo
memory. It also performs other initialization operations, such as installing the default 
interrupt handlers.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.
LabVIEW VXI VI Reference Manual 2-6 © National Instruments Corporation
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SetDevInfoLong
Sets information about a specified device in the device information table. The value bein
is a 32-bit unsigned integer.

la is the logical address of the device to set information for.

field is the field identification number.
12:  Base of A24/A32 memory.
13:  Size of A24/A32 memory.

longvalue is the information for that field.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

SetDevInfoShort
Sets information about a specified device in the device information table. The value bein
is a 16-bit unsigned integer.

la is the logical address of the device to set information for.

field is the field identification number.
2:  Logical address of the Commander.
3:  Mainframe.
4:  Slot.
5:  Manufacturer identification number.
7:  Model code.
9:  Device class.

10:  Extended subclass (if extended class device).
© National Instruments Corporation 2-7 LabVIEW VXI VI Reference Manual



Chapter 2 System Configuration and VXI Library Initialization VIs

ee 
11:  Address space used.
14:  Memory type and access time.
15:  Bit vector list of VXI interrupter lines.
16:  Bit vector list of VXI interrupt handler lines.
17:  Mainframe extender, controller information.

18:  Asynchronous mode control state.
19:  Response enable state.
20:  Protocols supported.
21:  Capability/status flags.
22:  Status state (Pass/Fail, Ready/Not Ready).

shortvalue is the information for that field.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

Bits Description

15 and 14 Reserved

13 1: Remote controller
0: Not remote controller

12 1: Child side extender
0: Parent side extender

11 1: Frame extender
0: Not frame extender

10 1: Extended controller

9 1: Embedded controller

15 to 13 Reserved

12 1: Child side extender
0: Parent side extender
LabVIEW VXI VI Reference Manual 2-8 © National Instruments Corporation
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SetDevInfoStr
Sets information about a specified device in the device information table. The informat
being set is contained in a string.

la is the logical address of the device to set information for.

field is the field identification number.
1:  Device name.
6:  Manufacturer name.
8:  Model name.

stringvalue is the buffer to receive information for that field.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.
© National Instruments Corporation 2-9 LabVIEW VXI VI Reference Manual
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Protocol VIs

This chapter describes the VXI Word Serial Commander Protocol VIs.
Word Serial communication is the minimal mode of communication 
between VXI Message-Based devices within the VXI 
Commander/Servant hierarchy. 

Locating Word Serial Commander VIs in LabVIEW
Select Windows»Show Diagram to go to the block diagram in LabVIEW.
From the Functions palette, choose Instrument I/O»VXI»Word Serial 
Commander Protocol to locate the Word Serial Commander Protocol V
in LabVIEW.

Finding Help Online for Word Serial Commander VIs
You can find helpful information about individual VIs online by using th
LabVIEW Help window. Open the Help window by choosing Help»Show 
Help in LabVIEW. When you place the cursor on a VI icon, the wiring 
diagram and parameter names for that VI appear in the Help window.

You also can double-click on the VI to open the front panel. When the H
window is open, you can get more information on each parameter by 
placing the cursor over the corresponding control or indicator on the V
front panel.

Handling Errors
The NI-VXI VIs use the LabVIEW error cluster method for handling 
errors. Each VI has error in and error out terminals. See Appendix A, Error 
Codes, for information on how the error codes relate to the previous sta
codes used by the NI-VXI VIs and a description of error in  and error out  
parameters.
Reference Manual
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Word Serial Commander VI Descriptions

WSabort
Performs a Forced or Unrecognized (Unsupported) Command abort of a Word Serial 
operation(s) in progress.

la is the logical address of the Message-Based device.

abortop is the operation to abort.
1: Forced Abort: aborts WSwrt, WSrd, and WStrg.
2: UnSupCom: aborts WScmd, WSLcmd, and WSEcmd.
3: Forced Abort: aborts WScmd, WSLcmd, and WSEcmd.
4: Forced Abort: aborts all Word Serial operations.
5: Async Abort: aborts all Word Serial operations immediately. 

Be careful when using this option. During a Word Serial query, 
Servant may be left in an invalid state if the operation is aborte
after writing the query and before reading the response registe
When using this option, the Word Serial operation is aborted
immediately as compared to using options 1, 3, and 4, where t
operation is not aborted until the response is read in that situat

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.
LabVIEW VXI VI Reference Manual 3-2 © National Instruments Corporation
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WSclr
Sends the Word Serial Clear command to a Message-Based device.

la is the logical address of the Message-Based device.

error in describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

WScmd
Sends a Word Serial command or query to a Message-Based device.

la is the logical address of the Message-Based device.

cmd is the Word Serial command value.

respflag is a Boolean value.
TRUE: Get a response (query).
FALSE: Do not get a response.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

response is the 16-bit response.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.
© National Instruments Corporation 3-3 LabVIEW VXI VI Reference Manual
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WSEcmd
Sends an Extended Longword Serial command or query to a Message-Based device.

respflag is a Boolean value.
TRUE: Get a response (query).
FALSE: Do not get a response.

la is the logical address of the Message-Based device.

cmdExt is the upper 16 bits of the 48-bit Extended Longword Serial 
command value.

cmd is the lower 32 bits of the 48-bit Extended Longword Serial comma
value.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

response is the 32-bit location to store the response.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.
LabVIEW VXI VI Reference Manual 3-4 © National Instruments Corporation
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WSgetTmo 
Gets the actual time period to wait before aborting a Word Serial, Longword Serial, or 
Extended Longword Serial Protocol transfer.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

actualtimo is the timeout period (in milliseconds).

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

WSLcmd
Sends a Longword Serial command or query to a Message-Based device.

la is the logical address of the Message-Based device.

cmd is the Longword Serial command value.

respflag is a Boolean value.
TRUE: Get a response (query).
FALSE: Do not get a response.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

response is the 32-bit location to store the response.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.
© National Instruments Corporation 3-5 LabVIEW VXI VI Reference Manual
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WSLresp
Retrieves a response to a previously sent Longword Serial Protocol query from a VXI 
Message-Based device. 

WSLcmd can send a query and automatically read a response. However, if you must br
the sending of the query and the reading of the response, you can use WSLcmd to se
query without reading the response and WSLresp to read the response.

Note This VI is intended for debugging purposes only.

la is the logical address of the Message-Based device.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

response is the 32-bit response.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

WSrd
Transfers the specified number of data bytes from a Message-Based device into a spe
local memory buffer, using the VXIbus Byte Transfer Protocol.

la is the logical address of the Message-Based device from which the b
is read.

count is the maximum number of bytes to transfer.

mode is the transfer mode bit vector. The following table describes the
mode bit vector corresponding to bits 15 through 0.
LabVIEW VXI VI Reference Manual 3-6 © National Instruments Corporation
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error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

buf is the data read.

retcount is the number of bytes actually transferred.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

Bit Event Signal

15 to 8 EOS character (valid if EOS termination)

4 EOS character termination
1: Terminate transfer on EOS bit.
0: Do not terminate transfer on EOS bit.

3 CR character termination
1: Terminate transfer on CR bit.
0: Do not terminate transfer on CR bit

2 LF character termination
1: Terminate transfer on LF bit.
0: Do not terminate transfer on LF bit

1 END bit termination suppression
0: Terminate transfer on END bit.
1: Do not terminate transfer on END bit.

0 Not DOR
0: Abort if not DOR.
1: Poll until DOR
© National Instruments Corporation 3-7 LabVIEW VXI VI Reference Manual
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WSresp
Retrieves a response for a previously sent Word Serial Protocol query from a VXI 
Message-Based device.

The WScmd VI can send a query and automatically read a response. However, if it is 
necessary to break up the sending of the query and the reading of the response, you c
the WScmd VI to send the query without reading the response and use the WSresp VI t
the response.

Note This VI is intended for debugging purposes only.

la is the logical address of the Message-Based device.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

response is the 16-bit response.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

WSsetTmo
Sets the time period to wait before aborting a Word Serial, Longword Serial, or Extend
Longword Serial Protocol transfer. It returns the actual timeout value set (the nearest tim
period possible greater than or equal to the timeout period specified).

timeout is the timeout period (in milliseconds).

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

actual timo is the actual timeout period set (in milliseconds).
LabVIEW VXI VI Reference Manual 3-8 © National Instruments Corporation
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error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

WStrg
Sends the Word Serial Trigger command to a Message-Based device.

la is the logical address of the Message-Based device.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

WSwrt
Transfers the specified number of data bytes from a memory buffer to a Message-Bas
device, using the VXIbus Byte Transfer Protocol.

la is the logical address of the Message-Based device to which the buff
written.

buf is the write buffer.

mode is the transfer mode bit vector,
for Bit 0

1: Poll until device is DIR.
0: Abort if device is not DIR.

for Bit 1
1: Set the END bit on the last byte of the transfer.
0: Clear the END bit on the last byte of the transfer.
© National Instruments Corporation 3-9 LabVIEW VXI VI Reference Manual
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error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

retcount is the number of bytes actually transferred.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.
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Word Serial Servant 
Protocol VIs

This chapter describes the VXI Word Serial Servant Protocol VIs. Wor
Serial communication is the minimal mode of communication between
VXI Message-Based devices within the VXI Commander/Servant 
hierarchy. The local CPU (the CPU on which the NI-VXI functions are 
running) uses the Word Serial Servant VIs to perform VXI Message-Ba
Word Serial Servant communication with its Commander. 

You use these VIs only in the case where the local CPU is not a Top-L
Commander (probably not the Resource Manager), such as in a multi
CPU situation. In a multiple CPU situation, the local CPU must allow t
Resource Manager device to configure the local CPU and can optiona
implement some basic message-transfer Word Serial communication 
its Commander. The four basic types of Word Serial Servant VIs are a
follows:

• Command reception

• Query reception and responding

• Buffer sending

• Buffer receiving

Word Serial Protocol is a simple 16-bit transfer protocol between a 
Commander and its Servants. The Commander polls specific bits in th
VXI Response register of the Servant to determine when a command 
be written, when a response can be read from the Data Low register, a
when a Word Serial protocol error occurs. Before a Commander can se
Word Serial command to a Servant, it must first poll the Write Ready (W
bit until it is asserted (set to 1). The Commander can then write the 
command to the Data Low register. 

If the Commander is sending a query, it first sends the query in the sa
manner as sending a command, but then continues by polling the Rea
Ready (RR) bit until it is asserted. It then reads the response from the 
Low register. A buffer write is a series of Byte Available Word Serial 
commands sent to the Servant, with the additional constraint that the D
In Ready (DIR) bit as well as the WR bit must be asserted before the 
Reference Manual
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Byte Available is sent. The lower 8 bits (bits 0 to 7) of the 16-bit comman
contains a single byte of data (bit 8 is the END bit). Therefore, one Byte 
Available is sent for each data byte in the buffer written. 

A buffer read is a series of Byte Request Word Serial queries sent to the 
Servant, with the additional constraint that the Data Out Ready (DOR) 
as well as the WR bit, must be asserted before the Byte Request is sent. The 
lower 8 bits (bits 0 to 7) of the 16-bit response contain a single byte of d
(bit 8 is the END bit). Therefore, one Byte Request is sent for each data byte
in the buffer read.

In addition to the WR, RR, DIR, and DOR bits that get polled during 
various Word Serial transfers, the ERR* bit is also checked. The ERR*
indicates that a Word Serial Protocol error has occurred. The Word Se
Protocol error can be Unsupported Command, Multiple Query Error 
(MQE), DIR Violation, DOR Violation, RR Violation, or WR Violation. 
The Word Serial Servant Protocol VIs allow the local CPU to generate 
of the Word Serial Protocol errors and to respond to the Read Protocol 
Error Word Serial query with the corresponding protocol error. The ER
bit assertion and unassertion are handled automatically.

The Longword Serial and Extended Longword Serial Protocols are sim
to the Word Serial Protocol, but involve 32-bit and 48-bit command 
transfers, respectively, instead of the 16-bit transfers of the Word Seria
Protocol. The VXI specification, however, provides no common comma
usages for these protocols. The commands are either VXI Reserved o
User-Defined. The NI-VXI interface gives you the ability to receive and
process any one of these commands. 

Locating Word Serial Servant Protocol VIs in LabVIEW
Select Windows»Show Diagram to go to the block diagram in LabVIEW.
From the Functions palette, choose Instrument I/O»VXI»Word Serial 
Servant Protocol to locate the Word Serial Servant Protocol VIs in 
LabVIEW.
LabVIEW VXI VI Reference Manual 4-2 © National Instruments Corporation
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Finding Help Online 
for Word Serial Servant Protocol VIs

You can find helpful information about individual VIs online by using th
LabVIEW Help window. Open the Help window by choosing Help»Show 
Help in LabVIEW. When you place the cursor on a VI icon, the wiring 
diagram and parameter names for that VI appear in the Help window.

You can also double-click on the VI to open the front panel. When the H
window is open, you can get more information on each parameter by 
placing the cursor over the corresponding control or indicator on the V
front panel.

Handling Errors
The NI-VXI VIs use the LabVIEW error cluster method for handling 
errors. Each VI has error in and error out terminals. See Appendix A, Error 
Codes, for information on how the error codes relate to the previous sta
codes used by the NI-VXI VIs and a description of error in  and error out  
parameters.

Word Serial Servant Protocol VI Descriptions

GenProtError 
Generates a Word Serial protocol error if one is not already pending. The Response re
bit ERR* is asserted if the value of the protocol error, proterr , is not FFFF. If proterr  is FFFF, 
ERR* is unasserted. If no previous error existed, the proterr  value is saved for response to a
future Read Protocol Error query via the VI RespProtError.

proterr is the protocol error to generate an error.
FFFF: Clear any protocol error condition.
FFFD: Multiple Query Error (MQE).
FFFC: Unsupported Command (UnSupCom). 
FFFB: Data In Ready violation (DIRviol). 
FFFA: Data Out Ready violation (DORviol). 
FFF9: Read Ready violation (RRviol). 
FFF8: Write Ready violation (WRviol).
© National Instruments Corporation 4-3 LabVIEW VXI VI Reference Manual
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Other values are reserved.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

GetWSScmdHandler
Returns the address of the current WSScmd interrupt handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

func is the address of the current WSScmd interrupt handler.
0: Word Serial Servant VIs not supported.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

GetWSSEcmdHandler
Returns the address of the current WSSEcmd interrupt handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

func is the address of the current WSSEcmd interrupt handler.
0: Word Serial Servant VIs not supported.
LabVIEW VXI VI Reference Manual 4-4 © National Instruments Corporation
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error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

GetWSSLcmdHandler
Returns the address of the current WSSLcmd interrupt handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

func is the address of the current WSSLcmd interrupt handler.
0: Word Serial Servant VIs not supported.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

GetWSSrdHandler
Returns the address of the current WSSrd done notification interrupt handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

func is the address of the current WSSrd done notification interrupt 
handler.

0: Word Serial Servant VIs not supported.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.
© National Instruments Corporation 4-5 LabVIEW VXI VI Reference Manual
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GetWSSwrtHandler
Returns the address of the current WSSwrt done notification interrupt handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

func is the address of the current WSSwrt done notification interrupt 
handler.

0: Word Serial Servant VIs not supported.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

RespProtError 
Responds to the Word Serial Read Protocol Error query with the last protocol error generate
via the GenProtError VI. The ERR* bit is unasserted.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.
LabVIEW VXI VI Reference Manual 4-6 © National Instruments Corporation
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SetWSScmdHandler
Replaces the current WSScmd interrupt handler with a specified handler.

func is the address of the new WSScmd interrupt handler obtained from
GetWSScmdHandler VI.

0: Set to DefaultWSScmdHandler.
3: LabVIEW Occurrence Handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

SetWSSEcmdHandler
Replaces the current WSSEcmd interrupt handler with a specified handler.

func is the address of the new WSSEcmd interrupt handler obtained fr
the GetWSScmdHandler VI.

0: Set to DefaultWSSEcmdHandler.
3: LabVIEW Occurrence Handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.
© National Instruments Corporation 4-7 LabVIEW VXI VI Reference Manual
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SetWSSLcmdHandler
Replaces the current WSSLcmd interrupt handler with a specified handler.

func is the address of the new WSSLcmd interrupt handler obtained fr
the GetWSScmdHandler VI.

0: Set to DefaultWSSLcmdHandler.
3: LabVIEW Occurrence Handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

SetWSSrdHandler
Replaces the current WSSrd done notification interrupt handler with a specified handle

func is the address of the new WSSrd done notification handler obtain
from the GetWSScmdHandler VI.

0: Set to DefaultWSSrdHandler.
3: LabVIEW Occurrence Handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.
LabVIEW VXI VI Reference Manual 4-8 © National Instruments Corporation
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 SetWSSwrtHandler
Replaces the current WSSwrt done notification interrupt handler with a specified hand

func is the address of the new WSSwrt done notification handler obtain
from the GetWSScmdHandler VI.

0: Set to DefaultWSSwrtHandler.
3: LabVIEW Occurrence Handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

WSSabort 
Aborts the Word Serial Servant operation(s) in progress.

abortop is the operation to abort, bit vector.

Bit Description

0 Abort WSSwrt

1 Abort WSSrd

2 Abort WSSsendResp

15 Initialize Word Serial Servant hardware. This includes 
aborting all Word Serial operations, clearing out errors, 
removing all pending Word Serial Servant interrupts, and
disabling the interrupts.
© National Instruments Corporation 4-9 LabVIEW VXI VI Reference Manual
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error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

WSScmdHandler
Waits until a Word Serial Protocol command or query is received from a VXI Message-B
Commander.

timeout specifies the number of milliseconds to wait for the interrupt.
–1: Forever.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

cmd is the 16-bit Word Serial command received.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

WSSdisable
Desensitizes the local CPU to interrupts generated when a Word Serial command is w
to the Data Low register or when a response is read from the Data Low register.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
LabVIEW VXI VI Reference Manual 4-10 © National Instruments Corporation
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error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

WSSEcmdHandler
Waits until an Extended Longword Serial Protocol command or query is received from a
Message-Based Commander.

timeout specifies the number of milliseconds to wait for the interrupt.
–1: Forever.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

cmdExt is the upper 16 bits of the 48-bit Extended Longword Serial 
command value.

cmd is the lower 32 bits of the 48-bit Extended Longword Serial comma
value.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

WSSenable
Sensitizes the local CPU to interrupts generated when a Word Serial command is writt
the Data Low register or when a response is read from the Data Low register.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.
© National Instruments Corporation 4-11 LabVIEW VXI VI Reference Manual
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WSSLcmdHandler
Waits until a Longword Serial Protocol command or query is received from a VXI 
Message-Based Commander.

timeout specifies the number of milliseconds to wait for the interrupt.
–1: Forever.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

cmd is the 32-bit Longword Serial command received.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

WSSLnoResp 
Acknowledges a received Longword Serial Protocol command that has no response an
asserts the Write Ready (WR) bit in the local CPU Response register. You must call th
after the processing of a Longword Serial Protocol command (queries are responded t
WSSLsendResp).

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.
LabVIEW VXI VI Reference Manual 4-12 © National Instruments Corporation
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WSSLsendResp 
Responds to a received Longword Serial Protocol query with a response and asserts t
WR bit in the local CPU Response register. You must call this VI after the processing o
Longword Serial Protocol query (commands are acknowledged with the WSSLnoResp

response is a 32-bit response.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

WSSnoResp 
Acknowledges a received Word Serial Protocol command that has no response and ass
WR bit in the local CPU Response register. You must call this VI after the processing o
Word Serial Protocol command (queries are responded to with the WSSsendResp VI)

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.
© National Instruments Corporation 4-13 LabVIEW VXI VI Reference Manual
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WSSrd 
Posts a read operation to begin receiving the specified number of data bytes from a 
Message-Based Commander into a specified memory buffer, using the VXIbus Byte Tra
Protocol.

count is the maximum number of bytes to transfer.

mode is the transfer mode bit vector.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

WSSrdHandler
Waits until a Word Serial Servant read operation (started with the WSSrd VI) terminate

timeout specifies the number of milliseconds to wait for the interrupt.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

count is the actual number of bytes received.

Bit Description

0 Determines the DIR signal mode to Commander 
0: Do not send DIR signal to Commander.
1: Send DIR signal to Commander.

1-15 0: Reserved.
LabVIEW VXI VI Reference Manual 4-14 © National Instruments Corporation
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buf is the buffer received from WSSrd operation.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

WSSsendResp 
Responds to a received Word Serial Protocol query with a response and asserts the WR
the local CPU Response register. You must call this VI after the processing of a Word S
Protocol query (commands are acknowledged with the WSSnoResp VI).

response is the 16-bit response.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

WSSwrt 
Posts the write operation to transfer the specified number of data bytes from a specifie
memory buffer to the Message-Based Commander, using the VXIbus Byte Transfer Pro

buf is the write buffer.

mode is the mode of transfer (bit vector).
© National Instruments Corporation 4-15 LabVIEW VXI VI Reference Manual
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error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

WSSwrtHandler
Waits until a Word Serial Servant write operation (started with the WSSwrt VI) terminat

timeout specifies the number of milliseconds to wait for the interrupt.
–1: Forever.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

count is the actual number of bytes sent.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

Bit Description

0 Determines the DOR signal mode to Commander 
(if enabled).
0: Do not send DOR signal to Commander.
1: Send DOR signal to Commander.

1 Specifies the END bit termination with last byte.
0: Do not END with the last byte.
1: Send END with the last byte.

2 to 15 0: Reserved.
LabVIEW VXI VI Reference Manual 4-16 © National Instruments Corporation
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Low-Level VXIbus Access VIs

This chapter describes how to use the VIs that give you the fastest ac
method for directly reading from or writing to any of the VXIbus addres
spaces.

There are several situations in which you must direct reads and writes t
different VXIbus address spaces, including some of the following:

• Register-Based device/instrument drivers

• Non-VXI/VME device/instrument drivers

• Accessing device-dependent registers on any type of VXI/VME dev

• Implementing shared memory protocols

Low-level and high-level access to the VXIbus, as the NI-VXI interface
defines them, are very similar in nature. Both sets of VIs can perform di
reads from and writes to any VXIbus address space with any privilege s
or byte order. However, the two interfaces have different emphases wi
respect to user protection, error checking, and access speed. 

Low-level VXIbus access is the fastest way to directly read from or wri
to the VXIbus address spaces. You access VXIbus address spaces by
reading and writing to offsets in the local CPU address space that 
correspond to addresses on the VXIbus.

The address space of the local CPU is mapped onto the VXIbus in are
called windows. The size and number of windows varies, depending on
hardware. The size of the window is always a power of two, where a 
multiple of the size of the window would encompass an entire VXIbus 
address space. The window base register determines the multiple tha
window can currently access. 

National Instruments MITE-based controllers, such as the PCI-MXI-2 a
the 700 and 800 series embedded controllers, allow you to configure t
size of the address space reserved for windows into VXIbus address sp
You configure this through either the T&M Explorer Utility on Win32 
platforms, or through VXIedit on other platforms.
Reference Manual
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Non-MITE based controllers have a fixed number of windows that eac
have a fixed size. The documentation that came with your hardware 
describes these specifications. When using non-MITE based controlle
the size parameter to the MapVXIAddress VI is ignored. The size 
parameter is supported only on Windows 32-bit and Solaris 2 operatin
systems.

Note You typically have the same access privileges and byte orders for all devices. 
VXIbus specification requires that VXI devices respond to the supervisory data
privilege state (address modifier codes). This increases the overall throughput
the program. Otherwise, the application must continually restore the state of th
windows into VXIbus address spaces.

NI-VXI uses a term within this chapter called the hardware context 
(or window). The hardware context for a VXI window consists of the VX
address space being accessed, the base offset into the address spac
access privilege, and the byte order for the accesses through the wind
Before accessing a particular address, you must set up the window wit
appropriate hardware context using the MapVXIAddress VI. This VI 
returns an address pointer you can use for accessing the window in th
future by using the VXIpeek and VXIpoke VIs. 

Multiple Accessors for a Window
Sometimes problems occur when an application requires different privil
states, byte orders, and/or base addresses within the same window. I
hardware context is changed by a subsequent call to MapVXIAddress o
other VIs such as SetPrivilege or SetByteOrder, previously mapped 
windows would not have their intended access parameters. There are
types of access privileges to a window that help solve this problem: Owner 
Privilege, and Access Only Privilege. These two privileges define which 
caller of the MapVXIAddress VI can change the settings of the 
corresponding window.

Owner Privilege
A caller can obtain Owner Privilege to a window by requesting owner 
privilege in the MapVXIAddress VI (via the accessparms parameter). This 
address mapping will not succeed if another address pointer with Own
Privilege or Access Only Privilege has already been mapped for that 
window. If the mapping succeeds, the VI returns a valid pointer and a 
non-negative status value. The window output parameter returned from the
MapVXIAddress VI associates the address pointer returned from the V
with a particular window and also signifies Owner Privilege to that 
LabVIEW VXI VI Reference Manual 5-2 © National Instruments Corporation
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window. Owner Privilege access is complete and exclusive. The caller
use the SetPrivilege, SetByteOrder, and SetContext VIs with this wind
to dynamically change the access privileges. Notice that if the executio
the MapVXIAddress VI succeeds for either Owner Privilege or Access
Only Privilege, the pointer remains valid in both cases until the 
UnMapVXIAddress VI is executed for the corresponding window. The
advantage of Owner Privilege access is that it gives complete and exclu
access for that window to the caller, so you can dynamically change th
access privileges. Because no other callers can succeed, there is no pr
with destroying the access state of another caller.

Access Only Privilege
You can obtain Access Only Privilege for a window by requesting acc
only privileges in the MapVXIAddress VI. With this privilege mode, you
can simultaneously have multiple address pointers to access a particu
window, while still guaranteeing that the hardware context does not cha
between accesses. The VI executes successfully under either of the 
following conditions:

• No address pointers are mapped for the window (first caller for Acc
Only Privilege for this window). The hardware context is set as 
requested in the call. The call returns a successful status and a va
address pointer and window  for Access Only Privilege.

• No address pointer has been mapped with Owner Privilege for the
required window. There are address pointers with Access Only 
Privilege, but they are using the same hardware context (privilege s
byte order, address range) for their accesses to the window. Beca
the hardware context is compatible, it does not need to be changed
VI returns a successful status and a valid address pointer and window 
for Access Only Privilege.

The successful call returns a valid pointer and a non-negative return va
The 32-bit window number signifies that the access privileges to the 
window are Access Only Privilege.

With Access Only Privilege, you cannot use the SetPrivilege, 
SetByteOrder, and SetContext VIs in your application to dynamically 
change the hardware context. No Access Only accessor can change t
state of the window. The initial Access Only call sets the hardware con
for the window, which cannot be changed until all Access Only access
have called the UnMapVXIAddress VI to free the window.

The GetPrivilege, GetByteOrder, and GetContext VIs succeed regardle
whether the caller has Owner Privilege or Access Only Privilege.
© National Instruments Corporation 5-3 LabVIEW VXI VI Reference Manual
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Locating Low-Level VXIbus Access VIs in LabVIEW
Select Windows»Show Diagram to go to the block diagram in LabVIEW.
From the Functions palette, choose Instrument I/O »VXI »
Low-Level VXIbus Access to locate the Low-Level VXIbus Access VIs 
in LabVIEW.

Finding Help Online for Low-Level VXIbus Access VIs
You can find helpful information about individual VIs online by using th
LabVIEW Help window. Open the Help window by choosing Help»Show 
Help in LabVIEW. When you place the cursor on a VI icon, the wiring 
diagram and parameter names for that VI appear in the Help window.

You can also double-click on the VI to open the front panel. When the H
window is open, you can get more information on each parameter by 
placing the cursor over the corresponding control or indicator on the V
front panel.

Handling Errors
The NI-VXI VIs use the LabVIEW error cluster method for handling 
errors. Each VI has error in and error out terminals. See Appendix A, Error 
Codes, for information on how the error codes relate to the previous sta
codes used by the NI-VXI VIs and a description of error in  and error out  
parameters.
LabVIEW VXI VI Reference Manual 5-4 © National Instruments Corporation
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Low-Level VXIbus Access VI Descriptions

GetByteOrder
Gets the byte/word order of data transferred into or out of the specified window.

window, as obtained from MapVXIAddress.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

ordermode is the byte/word order of data.
0: Motorola byte ordering.
1: Intel byte ordering.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

GetContext
Gets the current hardware interface settings (context) for the specified window.

window, as obtained from MapVXIAddress.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

context is the VXI hardware access context.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.
© National Instruments Corporation 5-5 LabVIEW VXI VI Reference Manual
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GetPrivilege
Gets the current VXI/VME access privilege for the specified window.

window, as returned from MapVXIAddress.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

priv is the access privilege.
0: Nonprivileged data access.
1: Supervisory data access.
2: Nonprivileged program access.
3: Supervisory program access.
4: Nonprivileged block access.
5: Supervisory block access.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

GetVXIbusStatus
Returns information about the state of the VXIbus in a specified controller (either an 
embedded CPU or an extended controller).

controller is the controller from which to get the status (–2: OR of all).

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

VXIbus  status is a cluster containing the VXIbus status, being compris
of the following elements:

Bus Error  is where a value of 1 means that a bus error occurr
on the last access.
LabVIEW VXI VI Reference Manual 5-6 © National Instruments Corporation
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Sysfail is where a value of 1 means that SYSFAIL* is asserted

ACfail  is where a value of 1 means that ACFAIL* is asserted.

Signal In is the number of signals queued.

VXI ints is a bit vector, where a value of 1 in bit positions 
0 through 6 means that the interrupt 1 through 7 is asserted.

ECL trigs is a bit vector, where a value of 1 in bit positions 
0 through 5 means that the trigger 0 through 5 is asserted.

TTL trigs  is a bit vector, where a value of 1 in bit positions 
0 through 7 means that the trigger 0 through 7 is asserted.

A value of –1 returned in any of the fields of the cluster signifies that th
is no hardware support to retrieve information for that particular VXIbu
state.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

GetVXIbusStatusInd
Returns information about the state of the VXIbus for the specified field in a particular 
controller.

controller is the controller from which to get the status (–2: OR of all).

field is the number of the field about which to return information.
1: Bus Error , where a value of 1 means that the last access BERR
2: Sysfail, where a value of 1 means that SYSFAIL* is asserted.
3: ACfail , where a value of 1 means that ACFAIL* is asserted.
4: Signal In, which is the number of signals queued.
5: VXI ints , which is a bit vector, where a value of 1 in bit position

0 through 6 means that the interrupt 1 through 7 is asserted.
6: ECL trigs , which is a bit vector, where a value of 1 in bit position

0 through 5 means that the trigger 0 through 5 is asserted.
7: TTL trigs , which is a bit vector, where a value of 1 in bit position

0 through 7 means that the trigger 0 through 7 is asserted.
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error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

VXIbus status in which a value of –1 in any of the fields means that the
is no hardware support for that particular state.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

GetWindowRange
Gets the range of addresses that a particular window, allocated with the MapVXIAddres
can currently access within a particular VXIbus address space.

window, as obtained from MapVXIAddress.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

windowbase is the base VXI address.

windowend is the end VXI address.
LabVIEW VXI VI Reference Manual 5-8 © National Instruments Corporation
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MapVXIAddress
Sets up a window into one of the VXI address spaces according to the access parame
specified, and returns a pointer to a local CPU address that accesses the specified VX
address. This VI also returns the window ID associated with the window, which is used
all other low-level VXIbus access VIs.

windowsize is the size of the window to be mapped (default is 64K). 

Note The size parameter is only supported on Win32 and Solaris 2 platforms using 
MITE based hardware. 

accessparms specifies the access parameters.
Bits 0 and 1 are used to specify the VXI address space.

1: A16.
2: A24.
3: A32.

Bits 2 through 4 are used to specify the access privilege.
0: Nonprivileged data access.
1: Supervisory data access.
2: Nonprivileged program access.
3: Supervisory program access.
4: Nonprivileged block access.
5: Supervisory block access.

Bit 5 = 0.
Bit 6 is used to specify the access mode.

0: Access only.
1: Owner access.

Bit 7 is used to specify the byte order.
0: Motorola.
1: Intel.

Bits 8 through 15 = 0.

address is the address within A16, A24, or A32.

timeout is the timeout (in milliseconds).

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.
© National Instruments Corporation 5-9 LabVIEW VXI VI Reference Manual
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window is the window number for use with other VIs.

addressptr is the pointer to local address for specified VXI address.
0:  Unable to get pointer.

Note To maintain compatibility and portability, use the pointer returned by this VI only
with the VXIpeek and VXIpoke VIs.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

windowbase is the base VXI address.

windowend is the end VXI address.

SetByteOrder
Sets the byte/word order of data transferred into or out of the specified window.

window, as obtained from MapVXIAddress.

ordermode is the byte/word order of data.
0: Motorola byte ordering.
1: Intel byte ordering.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.
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SetContext
Sets the current hardware interface settings (context) for the specified window. The valu
context should have been set previously by the GetContext VI.

window, as returned from MapVXIAddress.

context is the VXI hardware access context to install, as returned from
GetContext.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

SetPrivilege
Sets the VXI/VME access privilege for the specified window to the specified privilege s

window, as returned from MapVXIAddress.

priv is the access privilege.
0: Nonprivileged data access.
1: Supervisory data access.
2: Nonprivileged program access.
3: Supervisory program access.
4: Nonprivileged block access.
5: Supervisory block access.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
© National Instruments Corporation 5-11 LabVIEW VXI VI Reference Manual
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error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

UnMapVXIAddress
Deallocates a window that was allocated using the MapVXIAddress VI.

window, as returned from MapVXIAddress.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

VXIpeek
Reads a single byte, word, or longword from a specified VXI address by de-referencing
pointer obtained from MapVXIAddress.

addressptr is the address pointer obtained from MapVXIAddress.

width  specifies byte, word, or longword.
1: Byte.
2: Word.
4: Longword.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

value is the data value read.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
LabVIEW VXI VI Reference Manual 5-12 © National Instruments Corporation
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error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.

VXIpoke
Writes a single byte, word, or longword to a specified VXI address by dereferencing a po
obtained from MapVXIAddress.

addressptr is the address pointer obtained from MapVXIAddress.

width  specifies byte, word, or longword.
1: Byte.
2: Word.
4: Longword.

value is the data value to write.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out  cluster contains the same information. Otherwise, 
error out  describes the error status of this VI. See Appendix A, Error 
Codes, for specific error information.
© National Instruments Corporation 5-13 LabVIEW VXI VI Reference Manual



© National Instruments Corporation 6-1 LabVIEW VXI VI 
6

e 
ve 
 

te 
irect 
 

ice

 
rect 
te or 

he 

put 
ate, 
ically 

s 

 the 
o any 

ce 
High-Level VXIbus Access VIs

This chapter describes the VIs with which you have direct access to th
VXIbus address spaces. You can use these VIs to read, write, and mo
blocks of data between any of the VXIbus address spaces. Use these
easy-to-use VIs when execution speed is not a critical issue.

Use low-level and high-level VXIbus Access VIs to directly read or wri
to VXIbus addresses. There are several situations that require you to d
reads and writes to the different VXIbus address spaces, including the
following:

• Using register-based device/instrument drivers

• Using non-VXI/VME device/instrument drivers

• Accessing device-dependent registers on any type of VXI/VME dev

• Implementing shared memory protocols

Low-level and high-level access to the VXIbus, as the NI-VXI interface
defines them, are very similar in nature. Both sets of VIs can perform di
reads of and writes to any VXIbus address space with any privilege sta
byte order. However, the two interfaces have different emphases with 
respect to user protection, error checking, and access speed. 

High-level VXIbus access VIs need not take into account any of the 
considerations that are required by the low-level VXIbus access VIs. T
high-level VXIbus access VIs have all the necessary information for 
accessing a particular VXIbus address wholly contained within the VI in
parameters. The parameters prescribe the address space, privilege st
byte order, and offset within the address space. Bus errors are automat
trapped, and an appropriate error status is returned. 

More overhead is involved with the use of the high-level VXIbus acces
VIs, but if overall throughput of a particular access (for example, 
configuration or small number of accesses) is not the primary concern,
high-level VXIbus access VIs act as an easy-to-use interface that can d
VXIbus accesses necessary for an application.

All accesses to the VXIbus address spaces performed by use of the 
high-level VXIbus access VIs are fully protected. The hardware interfa
Reference Manual
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settings (context) for the applicable window are saved on entry to the VI
and restored upon exit. No other VIs in the NI-VXI interface, including t
low-level VXIbus access VIs, will conflict with the high-level VXIbus 
access VIs. You can use high-level and low-level VXIbus access VIs at
same time.

Locating High-Level VXIbus Access VIs in LabVIEW
Select Windows»Show Diagram to go to the block diagram in LabVIEW.
From the Functions palette, choose Instrument I/O»VXI»High-Level 
VXIbus Access to locate the High-Level VXIbus Access VIs in LabVIEW

Finding Help Online for High-Level VXIbus Access VIs
You can find helpful information about individual VIs online by using th
LabVIEW Help window. Open the Help window by choosing Help»Show 
Help in LabVIEW. When you place the cursor on a VI icon, the wiring 
diagram and parameter names for that VI appear in the Help window.

You also can double-click the VI to open the front panel. When the He
window is open, you can get more information on each parameter by 
placing the cursor over the corresponding control or indicator on the V
front panel.

Handling Errors
The NI-VXI VIs use the LabVIEW error cluster method for handling 
errors. Each VI has error in and error out terminals. See Appendix A, Error 
Codes, for information on how the error codes relate to the previous sta
codes used by the NI-VXI VIs and a description of error in  and error out  
parameters.
LabVIEW VXI VI Reference Manual 6-2 © National Instruments Corporation
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High-Level VXIbus Access VI Descriptions

VXIin
Reads a single byte, word, or longword from a specified VXI address with the specified
order and privilege state.

accessparms specifies the access parameters.
Bits 0 and 1 are used to specify the VXI address space.

1: A16.
2: A24.
3: A32.

Bits 2 through 4 specify the access privilege.
0: Nonprivileged data access.
1: Supervisory data access.
2: Nonprivileged program access.
3: Supervisory program access.
4: Nonprivileged block access.
5: Supervisory block access.

Bits 5 and 6 are reserved (should be 0).
Bit 7 specifies the byte order.

0: Motorola.
1: Intel.

Bits 8 through 15 are reserved (should be 0).

address is the VXI address within the specified space.

width is the read width.
1: Byte.
2: Word.
4: Longword.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

value is the value read.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
© National Instruments Corporation 6-3 LabVIEW VXI VI Reference Manual
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out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

VXIinReg
Reads a single word from a specified VXI register offset on the specified VXI device. T
register is read in Motorola byte order as nonprivileged data.

la is the logical address of the device to read from.

reg is the offset within VXI logical address registers.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

value is the value read from the VXI register of the device.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

VXImove
Copies a block of memory from a specified source location in any address space (local
A24, A32) to a specified destination in any address space.

length is the number of elements to transfer.

destVXIaddr is the destination address in the VXI address space 
(applicable only if the address space specified by destparms indicates VXI 
address space).
LabVIEW VXI VI Reference Manual 6-4 © National Instruments Corporation
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srcU32array is the source unsigned longword array in the local addres
space (applicable only if the address space specified by srcparms indicates 
local address space, and you want to transfer data from an array of 
longwords).

srcparms specifies the source parameters.
Bits 0 and 1 are used to specify the source address space.

0: Local (bits 2, 3, 4, and 7 should be 0).
1: A16.
2: A24.
3: A32.

Bits 2 through 4 are used to specify the access privilege.
0: Nonprivileged data access.
1: Supervisory data access.
2: Nonprivileged program access.
3: Supervisory program access.
4: Nonprivileged block access.
5: Supervisory block access.

Bits 5 and 6 are reserved (should be 0).
Bit 7 is used to specify the byte order.

0: Motorola.
1: Intel.

Bits 8 through 15 are reserved (should be 0).

srcVXIaddr is the source address in the VXI address space (applicab
only if the address space specified by srcparms indicates VXI address 
space).

srcU8array is the source unsigned byte array in the local address spac
(applicable only if the address space specified by srcparms indicates local 
address space, and you want to transfer data from an array of bytes).

srcU16array is the source unsigned word array in the local address sp
(applicable only if the address space specified by srcparms indicates local 
address space, and you want to transfer data from an array of words).

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.
© National Instruments Corporation 6-5 LabVIEW VXI VI Reference Manual
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dstparms specifies the destination parameters.
Bits 0 and 1 are used to specify the destination address space.

0: Local (bits 2, 3, 4, and 7 should be 0).
1: A16.
2: A24.
3: A32.

Bits 2 through 4 are used to specify the access privilege.
0: Nonprivileged data access.
1: Supervisory data access.
2: Nonprivileged program access.
3: Supervisory program access.
4: Nonprivileged block access.
5: Supervisory block access.

Bits 5 and 6 are reserved (should be 0).
Bit 7 is used to specify the byte order.

0: Motorola.
1: Intel.

Bits 8 through 15 are reserved (should be 0).

width specifies byte, word, or longword.
1: Byte.
2: Word.
4: Longword.

destU8array is the destination unsigned byte array in the local address
space (applicable only if the address space specified by destparms 
indicates local address space, and you want to transfer data into an arr
bytes).

destU16array is the destination unsigned word array in the local addre
space (applicable only if the address space specified by destparms 
indicates local address space, and you want to transfer data into an arr
words).

destU32array is the destination unsigned longword array in the local 
address space (applicable only if the address space specified by destparms 
indicates local address space and you want to transfer data into an arr
longwords).

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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VXIout
Writes a single byte, word, or longword to a specified VXI address with the specified b
order and privilege state.

value is the data value to write.

accessparms specifies the access parameters.
Bits 0 and 1 are used to specify the VXI address space.

1: A16.
2: A24.
3: A32.

Bits 2 through 4 are used to specify the access privilege.
0: Nonprivileged data access.
1: Supervisory data access.
2: Nonprivileged program access.
3: Supervisory program access.
4: Nonprivileged block access.
5: Supervisory block access.

Bits 5 and 6 are reserved (should be 0).
Bit 7 specifies the byte order.

0: Motorola.
1: Intel.

Bits 8 through 15 are reserved (should be 0).

address is the VXI address within the specified space.

width is the write width.
1: Byte.
2: Word.
4: Longword.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
© National Instruments Corporation 6-7 LabVIEW VXI VI Reference Manual
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VXIoutReg
Writes a single word to a specified VXI register offset on the specified VXI device. The
register is written in Motorola byte order and as nonprivileged data.

la is the logical address of the device to write to.

reg is the offset within VXI logical address registers.

value is the value written to the VXI register of the device.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
LabVIEW VXI VI Reference Manual 6-8 © National Instruments Corporation
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Local Resource Access VIs

This chapter describes the VIs you use to access miscellaneous local
resources such as the local CPU VXI register set and Slot 0 MODID 
operations.

Access to the local logical address of the CPU is required for sending 
correct VXI signal values to other devices. Reading local VXI registers
required for retrieving configuration information. Exercising the local CP
MODID capabilities (if the local CPU is a VXI Slot 0 device) can be helpf
in debugging the slot association (MODID) capability of a prototype VX
device.

Locating Local Resource Access VIs in LabVIEW
Select Windows»Show Diagram to go to the block diagram in LabVIEW.
From the Functions palette, choose Instrument I/O»VXI»Local 
Resource Access to locate the Local Resource Access VIs in LabVIEW

Finding Help Online for Local Resource Access VIs
You can find helpful information about individual VIs online by using th
LabVIEW Help window. Open the Help window by choosing Help»Show 
Help in LabVIEW. When you place the cursor on a VI icon, the wiring 
diagram and parameter names for that VI appear in the Help window.

You also can double-click the VI to open the front panel. When the He
window is open, you can get more information on each parameter by 
placing the cursor over the corresponding control or indicator on the V
front panel.

Handling Errors
The NI-VXI VIs use the LabVIEW error cluster method for handling 
errors. Each VI has error in and error out terminals. See Appendix A, Error 
Codes, for information on how the error codes relate to the previous sta
codes used by the NI-VXI VIs and a description of error in  and error out  
parameters.
Reference Manual
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Local Resource Access VI Descriptions

GetMyLA
Gets the logical address of the local VXI device (the VXI device on which this copy of t
NI-VXI software is running).

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

la is the logical address of the local device.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

ReadMODID
Senses the MODID lines of the VXIbus backplane. This VI applies only to the local dev
which must be a Slot 0 device.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

modid is a bit vector for Bits 12 through 0, corresponding to Slots 
12 through 0, respectively.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
LabVIEW VXI VI Reference Manual 7-2 © National Instruments Corporation
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SetMODID
Controls the assertion of the MODID lines of the VXIbus backplane. This VI applies onl
the local device, which must be a Slot 0 device.

enable defines the handling of the MODID enable bit.
1: Set MODID enable bit.
0: Clear MODID enable bit.

modid is a bit vector for Bits 12 through 0, corresponding to Slots 
12 through 0, respectively.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

VXIinLR
Reads a single byte, word, or longword from a particular VXI register on the local VXI 
device. The register is read in Motorola byte order and as nonprivileged data.

reg is the offset within VXI logical address registers.

width  specifies byte, word, or longword.
1: Byte.
2: Word.
4: Longword.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

value is the data value read.
© National Instruments Corporation 7-3 LabVIEW VXI VI Reference Manual
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error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

VXIoutLR
Writes a single byte, word, or longword to a particular VXI register on the local VXI dev
The register is written in Motorola byte order and as nonprivileged data.

reg is the offset within VXI logical address registers.

width  specifies byte, word, or longword.
1: Byte.
2: Word.
4: Longword.

value is the data value to write.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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Shared Memory Access VIs

This chapter describes the VIs you use to perform shared memory 
operations. These VIs are useful for shared memory operation type 
communication. In shared memory applications, Local CPU RAM is 
shared on the VXI backplane.

On hardware platforms that support shared memory, you can use thes
to lock down memory on your controller. Other VXI bus masters can th
directly access this memory.

To set up shared memory, use T&M explorer or VXI edit to configure yo
controller to request VXI address space from the Resource Manager. S
operating systems require you to lock down memory at system startup.
can do this by setting the Shared Memory Pool field in either of these 
utilities.

Locating Shared Memory Access VIs in LabVIEW
Select Window»Show Diagrams to go to the block diagram in LabVIEW.
From the Functions palette, choose Instrument I/O»VXI»Memory 
Resource to locate the Local Resource Access VIs in LabView.

Finding Help Online for Shared Memory Access VIs
You can find helpful information about individual VIs online by using th
LabVIEW Help window. Open the Help window by choosing Help»Show 
Help in LabVIEW. When you place the cursor on a VI icon, the wiring 
diagram and parameter names for that VI appear in the Help window. Y
also can double-click the VI to open the front panel. When the Help 
window is open, you can get more information on each parameter by 
placing the cursor over the corresponding control or indicator on the V
front panel.
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Handling Errors
The NI-VXI VIs now use the LabVIEW error cluster method for handlin
errors. Each VI has error in and error out terminals. See Appendix A, Error 
Codes, for information on how the new error codes relate to the old sta
codes used by the NI-VXI VIs and a description of error in  and error out  
parameters.

Shared Memory Resource VI Descriptions

VXImemAlloc
Allocates dynamic system RAM from the VXI Shared RAM area of the local CPU and ret
both the local and remote VXI addresses. The VXI address space is the same as the sp
which the local device is porting memory. You can use this VI to set up shared memory
transfers.

size is the number of bytes to allocate.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

useraddr is the returned application memory buffer address. This buffe
cannot be directly accessed by LabVIEW. Use the VXImemCopy VI to
access data in this buffer.

vxiaddr  is the returned remote VXI memory buffer address.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
LabVIEW VXI VI Reference Manual 8-2 © National Instruments Corporation
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VXImemCopy
Copies data into the local memory array from the VXI Shared RAM area of the local 
CPU allocated by VXImemAlloc or copies data from the local memory array into the VX
Shared RAM.

width is the copy width.
1: Byte.
2: Word.
4: Longword.

direction designates the area from which you want to copy data.
1: Copy data from the specified source array to the useraddr

parameter.
0: Copy data from the useraddr parameter into the destination

array specified by the width  parameter.

useraddr is the Shared RAM address to copy data from or into.

srcbufU8array is the source unsigned byte array in the local address sp
(applicable only if the direction parameter indicates that you want to cop
data from an array of bytes into the Shared RAM).

srcbufU16array is the source unsigned word array in the local address
space (applicable only if the direction parameter indicates that you want to
copy data from an array of words into the Shared RAM).

srcbufU32array is the source unsigned longword array in the local addre
space (applicable only if the direction parameter indicates that you want to
copy data from an array of longwords into the Shared RAM).

size is the number of elements to copy.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

dstbufU8array is the destination unsigned byte array in the local addre
space (applicable only if the direction parameter indicates that you want to
© National Instruments Corporation 8-3 LabVIEW VXI VI Reference Manual
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copy data into an array of bytes from the Shared RAM and the width  
parameter indicates byte transfers).

dstbufU16array is the destination unsigned word array in the local addre
space (applicable only if the direction parameter indicates that you want to
copy data into an array of words from the Shared RAM and the width  
parameter indicates word transfers).

dstbufU32array is the destination unsigned longword array in the loca
address space (applicable only if the direction parameter indicates that you
want to copy data from an array of longwords from the Shared RAM a
the width  parameter indicates longword transfers).

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

VXImemFree
Deallocates dynamic system RAM from the VXI Shared RAM area of the local CPU that
allocated using the VXImemAlloc VI.

useraddr is the application memory buffer address to free.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
LabVIEW VXI VI Reference Manual 8-4 © National Instruments Corporation
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VXI Signal VIs

This chapter describes the VIs you use to specify signal routing, manipu
the global signal queue, and wait for a particular VXI signal to be receiv

VXI signals are a basic form of asynchronous communication that VXI b
master devices use. A VXI signal is simply a 16-bit value written to the
Signal register of a VXI Message-Based device. Normally, the write to 
Signal register generates a local CPU interrupt, and the local CPU the
acquires the signal value in some device-specific manner. All National
Instruments hardware platforms have a hardware FIFO to accumulate
signal values while waiting for the local CPU to retrieve them. The form
of the 16-bit signal value is defined by the VXIbus specification. VXI 
signals and status/ID values contain the VXI logical address of the sen
device in the lower 8 bits of the VXI signal or status/ID value. The upp
8 bits of the 16-bit value depends on the VXI device type. 

Three methods are available for handling VXI signals in LabVIEW. On
method is to allow the NI-VXI default signal handler to handle the sign
From the point of view of your LabVIEW application, using the default 
signal handler essentially results in the signal being ignored. 

A second method for handling signals is by placing them into a global 
signal queue. The RouteSignal VI specifies which types of signals are
handled by the default signal handler and which signals are placed on
global signal queue. (By default, when signals are initially enabled with 
EnableSignalInt VI, all signals are routed to the default signal handler.) 
VIs used to access the signal queue are SignalDeq, SignalEnq, and 
SignalJam.

The third method for handling signals is with the WaitForSignal VI. Thi
VI can be used to suspend the execution of a VI until a particular sign
(or one of a set of signals) arrives. In LabVIEW, any number of 
WaitForSignal VIs can be executed in parallel, even for the same logic
address. When using the WaitForSignal VI, you should use RouteSign
route the desired signals to the global signal queue. The WaitForSigna
will first check the queue to see if the signal(s) in which you are interes
have already been received.
Reference Manual
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Locating VXI Signal VIs in LabVIEW
Select Windows»Show Diagram to go to the block diagram in LabVIEW.
From the Functions palette, choose Instrument I/O»VXI»VXI Signal to 
locate the VXI Signal VIs in LabVIEW.

Finding Help Online for VXI Signal VIs
You can find helpful information about individual VIs online by using th
LabVIEW Help window. Open the Help window by choosing Help»Show 
Help in LabVIEW. When you place the cursor on a VI icon, the wiring 
diagram and parameter names for that VI appear in the Help window.

You also can double-click the VI to open the front panel. When the He
window is open, you can get more information on each parameter by 
placing the cursor over the corresponding control or indicator on the V
front panel.

Handling Errors
The NI-VXI VIs use the LabVIEW error cluster method for handling 
errors. Each VI has error in and error out terminals. See Appendix A, Error 
Codes, for information on how the error codes relate to the previous sta
codes used by the NI-VXI VIs and a description of error in  and error out  
parameters.
LabVIEW VXI VI Reference Manual 9-2 © National Instruments Corporation
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VXI Signal VI Descriptions

DisableSignalInt
Desensitizes the local CPU to interrupts generated by writes to the local VXI Signal reg
While disabled, no VXI signals are processed. If the local VXI hardware Signal registe
implemented as a FIFO, signals are held in the FIFO until the signal interrupt is enable
the EnableSignalInt VI.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

EnableSignalInt
Sensitizes the local CPU to interrupts generated by writes to the local VXI Signal regis

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
© National Instruments Corporation 9-3 LabVIEW VXI VI Reference Manual
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GetSignalHandler
Returns the address of the current signal interrupt handler for a specified logical addre

la signifies the logical address for finding the address of the signal interr
handler.

– 2: Unknown (miscellaneous) signal source.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

func is the pointer to the current signal interrupt handler for the specifi
logical address.

0: Invalid la.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

RouteSignal
Specifies how each type of signal is to be processed for each logical address. A signal 
enqueued on a global signal queue (for later dequeuing via SignalDeq) or handled at int
service routine time by the default signal handler.

la specifies the routing for the logical address.
–1: All known logical addresses.

modemask is a bit vector that specifies whether each type of signal is 
enqueued or handled by the signal handler.

A zero in any bit position causes signals of the associated type to be queued on the gl
signal queue, and all other signals are handled by the signal handler.
LabVIEW VXI VI Reference Manual 9-4 © National Instruments Corporation
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The following table describes the event signals that correspond to bits 14 through 8 wh
la is a Message-Based device.

The following table shows the response signals that correspond to bits 7 through 0 whela is 
a Message-Based device.

Bit Event Signal

14 User-defined Events

13 VXI Reserved Events

12 Shared Memory Events

11 Unrecognized Command Events

10 Request False (REQF) Events

9 Request True (REQT) Events

8 No Cause Given Events

Bit Event Signal

7 Unused

6 B14 (reserved for future definition)

5 Data Out Ready (DOR)

4 Data In Ready (DIR)

3 Protocol Error (ERR)

2 Read Ready (RR)

1 Write Ready (WR)

0 Fast Handshake (FHS)
© National Instruments Corporation 9-5 LabVIEW VXI VI Reference Manual
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The following table shows the type of signal values that correspond to bits 15 through 0 
la is a non-Message-Based device.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

SetSignalHandler
Replaces the current signal interrupt handler for a logical address with a specified han

la specifies the logical address to set the handler to. 
–1: All known logical addresses.
–2: Unknown (miscellaneous) signal handler.

func is the pointer to the new signal interrupt handler.
0: Set to DefaultSignalHandler.
3: LabVIEW occurrence handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

Bit Type of Signal (status/ID) Values

15 to 8 Active high bit (if 1 in bits 15 to 8, respectively)

7 to 0 Active low bit (if 0 in bits 15 to 8, respectively)
LabVIEW VXI VI Reference Manual 9-6 © National Instruments Corporation
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SignalDeq
Gets a signal specified by the signalmask from the signal queue for the specified logic
address.

la specifies the logical address from which to dequeue signal.
255: VME interrupt routed to signal queue.
–1: any known la.

signalmask is a bit vector that specifies the types of signals to dequeue

A 1 in any bit position causes the subroutine to dequeue signals of the associated type

The following table describes the event signals that correspond to bits 14 through 8 whla 
is a Message-Based device.

Bit Event Signal

14 User-Defined Events

13 VXI Reserved Events

12 Shared Memory Events

11 Unrecognized Command Events

10 Request False (REQF) Events

9 Request True (REQT) Events

8 No Cause Given Events
© National Instruments Corporation 9-7 LabVIEW VXI VI Reference Manual
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The following table shows the response signals that correspond to bits 7 through 0 wh
la is a Message-Based device.

The following table shows the type of signal values that correspond to bits 15 through 0 
la is a non-Message-Based device, or if la = 255 (VME status/ID).

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

signal is the signal value dequeued from the signal queue.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

Bit Event Signal

7 Unused

6 B14 (reserved for future definition)

5 Data Out Ready (DOR)

4 Data In Ready (DIR)

3 Protocol Error (ERR)

2 Read Ready (RR)

1 Write Ready (WR)

0 Fast Handshake (FHS)

Bit Event Signal

15 to 8 Active high bit (if 1 in bits 15 to 8, respectively)

7 to 0 Active low bit (if 0 in bits 15 to 8, respectively)
LabVIEW VXI VI Reference Manual 9-8 © National Instruments Corporation
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SignalEnq
Puts a signal on the tail of the signal queue for the specified logical address.

signal is the value to enqueue at the tail of the signal queue.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

SignalHandler
Waits until a Signal interrupt occurs.

la specifies the logical address of the signals to be handled
–1: All known logical addresses.
–2: Unknown (miscellaneous) signal sources.

timeout specifies the number of milliseconds to wait for the interrupt
–1: Forever.

signal specifies the actual 16-bit VXI signal received.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out  contains error information. If the error in cluster indicated an
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
© National Instruments Corporation 9-9 LabVIEW VXI VI Reference Manual
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SignalJam
Puts a signal on the head of the signal queue for the specified logical address.

Note This VI is intended for debugging purposes only.

signal is the signal value to put on the head of the queue.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

WaitForSignal
Waits for a specified type of signal to be received from a specified logical address. A s
mask defines the type(s) of signals that the application program waits for. The timeout 
specifies the maximum amount of time (in milliseconds) to wait until the signal occurs.

la is the logical address of the device sourcing the signal.
255: VME interrupt routed to signal queue.
–1: any known la.

signalmask is a bit vector that indicates the type(s) of signals that the 
application will wait for.

A one in any bit position causes the subroutine to detect signals of the associated type
LabVIEW VXI VI Reference Manual 9-10 © National Instruments Corporation
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The following table shows the event signals that correspond to bits 14 through 8, whenla is 
a Message-Based device.

The following table shows the response signals that correspond to bits 7 through 0, whla 
is a Message-Based device.

Bit Event Signal

14 User-defined Events

13 VXI Reserved Events

12 Shared Memory Events

11 Unrecognized Command Events

10 Request False (REQF) Events

9 Request True (REQT) Events

8 No Cause Given Events

Bit Event Signal

7 Unused

6 B14 (reserved for future definition)

5 Data Out Ready (DOR)

4 Data In Ready (DIR)

3 Protocol Error (ERR)

2 Read Ready (RR)

1 Write Ready (WR)

0 Fast Handshake (FHS)
© National Instruments Corporation 9-11 LabVIEW VXI VI Reference Manual
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The following table shows the type of signal values that correspond to bits 15 through 0  
la is a non-Message-Based device, or if la = 255 (VME status/ID). 

timeout is the maximum amount of time (in milliseconds) to wait until th
signal occurs.

0: Forever.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

retsignal is the signal received (upper byte of the 16-bit signal).

retsignalmask is a bit vector that indicates the type(s) of signals that th
application received. The bits have the same meanings as given for the 
parameter signalmask.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

Bit Event Signal

15 to 8 Active High Bit (if 1 in bits 15 to 8, respectively)

7 to 0 Active Low Bit (if 0 in bits 15 to 8, respectively)
LabVIEW VXI VI Reference Manual 9-12 © National Instruments Corporation
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VXI Interrupt VIs

This chapter describes the VIs that control VXI interrupts. VXI interrup
are a basic form of asynchronous communication used by VXI devices w
VXI interrupter support. In VME, a device asserts a VME interrupt line
and the VME interrupt handler device acknowledges the interrupt. Dur
the VME interrupt acknowledge cycle, a status/ID value is returned. 

On most 680x0-based VME CPUs, this value is used as a local interru
vector value and routed directly to the 680x0 processor. This value is u
to look up which interrupt service routine to invoke. In VXI, however, th
VXI interrupt acknowledge cycle returns (at a minimum) a 16-bit status/
value. This 16-bit status/ID value is data, not a vector base location. T
definition of the 16-bit vector is specified by the VXIbus specification an
is the same as for a VXI signal. The lower 8 bits of the status/ID value
the VXI logical address of the interrupting device, while the upper 8 bi
specifies the reason for interrupting.

Because the interrupt status/ID value for a VXI device is the same as a 
signal value, VXI interrupts can be handled as VXI signals. The 
RouteVXIint VI is used to specify that a VXI interrupt be handled as a V
signal. If a VXI interrupt is not routed to be processed as a VXI signal, 
interrupt will be handled by the NI-VXI default VXI interrupt handler, 
resulting in your LabVIEW application essentially ignoring the interrup

To sensitize and desensitize the LabVIEW application to VXI interrupt
routed to the VXI interrupt handlers, use the EnableVXIint and 
DisableVXIint VIs, respectively. To enable queuing of the interrupt afte
executing RouteVXIint, you must execute the EnableVXItoSignalInt VI
Once the VXI interrupt is routed and enabled, the interrupt is handled 
VXI signal using the signal queue VIs. To disable queuing of the interru
you must execute the DisableVXItoSignalInt VI. For more information 
concerning VXI signal VIs, refer to Chapter 9, VXI Signal VIs.
bVIEW VXI VI Reference Manual
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Locating VXI Interrupt VIs in LabVIEW
Select Windows»Show Diagram to go to the block diagram in LabVIEW.
From the Functions palette, choose Instrument I/O»VXI»VXI Interrupt 
to locate the VXI Interrupt VIs in LabVIEW.

Finding Help Online for VXI Interrupt VIs
You can find helpful information about individual VIs online by using th
LabVIEW Help window. Open the Help window by choosing Help»Show 
Help in LabVIEW. When you place the cursor on a VI icon, the wiring 
diagram and parameter names for that VI appear in the Help window.

You also can double-click the VI to open the front panel. When the He
window is open, you can get more information on each parameter by 
placing the cursor over the corresponding control or indicator on the V
front panel.

Handling Errors
The NI-VXI VIs use the LabVIEW error cluster method for handling 
errors. Each VI has error in and error out terminals. See Appendix A, Error 
Codes, for information on how the error codes relate to the previous sta
codes used by the NI-VXI VIs and a description of error in  and error out  
parameters.
LabVIEW VXI VI Reference Manual 10-2 © National Instruments Corporation
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VXI Interrupt VI Descriptions

AcknowledgeVXIint
Performs an IACK cycle on the VXIbus on the specified controller (either an embedded 
or an extended controller) for a particular VXI interrupt level.

VXI interrupts are automatically acknowledged when enabled by the EnableVXItoSigna
and EnableVXIint VIs. Use this VI to manually acknowledge VXI interrupts that the loc
device is not enabled to receive.

Note This VI is intended for debugging purposes only.

controller is the controller on which to acknowledge the interrupt.

level is the interrupt level to acknowledge.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

statusID is the status/ID obtained during the IACK cycle.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

AssertVXIint
Asserts a VXI interrupt line on the specified controller (either an embedded CPU or an
extended controller).

When the VXI interrupt is acknowledged (a VXI IACK cycle occurs), the specified status
is passed to the device that acknowledges the VXI interrupt.

controller is the controller on which to assert the interrupt.
© National Instruments Corporation 10-3 LabVIEW VXI VI Reference Manual
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level is the interrupt level to assert.

statusID is the status/ID to present during the IACK cycle.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

DeAssertVXIint
Asynchronously deasserts a VXI interrupt line on the specified controller (either an 
embedded CPU or an extended controller) that was previously asserted by the 
AssertVXIint VI.

Note This VI is intended for debugging purposes only. Deasserting a VXI interrupt ca
cause a violation of the VME and VXIbus specifications.

controller is the controller on which to deassert the interrupt.

level is the interrupt level to deassert.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
LabVIEW VXI VI Reference Manual 10-4 © National Instruments Corporation
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DisableVXIint
Desensitizes the local CPU to specified VXI interrupts generated in the specified contr
which are routed to be handled as VXI interrupts (not as signals) via the RouteVXIint V

controller  specifies the controller (embedded or extended) to disable t
interrupts.

levels is a vector of VXI interrupt levels to disable.

Bits 6 to 0 correspond to VXI interrupt levels 7 to 1, respectively.
1: Disable for appropriate level.
0: Leave at current setting.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

DisableVXItoSignalInt
Desensitizes the local CPU to specified VXI interrupts generated in the specified contr
which are routed to be handled as VXI signals (not as interrupts) via the RouteVXIint V

controller  specifies the controller (embedded or extended) to disable t
interrupts.

levels is a vector of VXI interrupt levels to disable.
Bits 6 to 0 correspond to VXI interrupt levels 7 to 1, respectively.

1: Disable for appropriate level.
0: Leave at current setting.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.
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error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

EnableVXIint
Sensitizes the local CPU to specified VXI interrupts generated in the specified controlle
which are routed to be handled as VXI interrupts (not as signals) via the RouteVXIint V

The RM assigns the interrupt levels automatically. Use the GetDevInfoShort VI to retriev
assigned levels. Notice that each VXI interrupt is physically enabled only if the RouteVX
VI has specified that the VXI interrupt be routed and then handled as a VXI/VME interr

controller  specifies the controller (embedded or extended) to enable th
interrupts.

levels is a vector of VXI interrupt levels to enable.
Bits 6 to 0 correspond to VXI interrupt levels 7 to 1, respectively.

1: Enable for appropriate level.
0: Leave at current setting.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

EnableVXItoSignalInt
Sensitizes the local CPU to specified VXI interrupts generated in the specified controlle
which are routed to be handled as VXI signals (not as interrupts) via the RouteVXIint V

The RM assigns the interrupt levels automatically. GetDevInfoShort can be used to ret
the assigned levels. Notice that each VXI interrupt is physically enabled only if the 
LabVIEW VXI VI Reference Manual 10-6 © National Instruments Corporation
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RouteVXIint VI has specified that the VXI interrupt be routed and then handled as a 
VXI/VME signal.

controller  specifies the controller (embedded or extended) to enable th
interrupts.

levels is a vector of VXI interrupt levels to enable.
Bits 6 to 0 correspond to VXI interrupt levels 7 to 1, respectively.

1: Enable for appropriate level.
0: Leave at current setting.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

GetVXIintHandler
Returns the address of the current interrupt handler for a specified VXIbus interrupt lev

level is the VXI interrupt level associated with the handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

func is the pointer to the current interrupt handler for a specified VXIbu
interrupt level.

0: Invalid level or no hardware support.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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RouteVXIint
Specifies whether the status/ID value retrieved from a VXI interrupt acknowledge cycle
routed to the VXI interrupt handler or to the signal processing routine.

The RouteVXIint VI dynamically enables and disables the appropriate VXI interrupts ba
on the settings from calls to the EnableVXItoSignalInt and EnableVXIint VIs. 

controller  specifies the controller (embedded or extended) to enable th
interrupts.

Sroute is a bit vector that specifies whether to handle a VXI interrupt a
signal or route it to the VXI interrupt handler routine.

Bits 6 to 0 correspond to VXI interrupt levels 7 to 1, respectively.
1: Handle VXI interrupt for this level as a signal.
0: Handle VXI interrupt as a VXI interrupt.

Bits 14 to 8 correspond to VXI interrupt levels 7 to 1, respectively.
1: Route as 8-bit VME status/ID.
0: Route as 16-bit VXI status/ID.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

SetVXIintHandler
Replaces the current interrupt handler for the specified VXIbus interrupt levels with a 
specified handler.

levels is a bit vector of VXI interrupt levels. Bits 6 to 0 correspond to VX
interrupt levels 7 to 1, respectively.

1: Set.
0: Do not set handler.
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func is the pointer to the new VXI interrupt handler.
0: Set to DefaultVXIintHandler.
3: LabVIEW occurrence handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

VXIintAcknowledgeMode
Specifies whether to handle the VXI interrupt acknowledge cycle for the specified contr
(embedded or extended) for the specified levels as Release on Acknowledge (ROAK) 
interrupts or as Release on Register Access (RORA) interrupts.

If the VXI interrupt level is handled as a RORA VXI interrupt, the local interrupt generat
is automatically inhibited when the VXI interrupt acknowledge is performed. The 
EnableVXIint or EnableVXItoSignalInt VIs must be called to reenable the appropriate V
interrupt level whenever a RORA VXI interrupt occurs.

controller  specifies the controller (embedded or extended) for which to
specify the routing.

modes is a vector of VXI interrupt levels to set to RORA/ROAK interrup
mode.
Bits 6 to 0 correspond to VXI interrupt levels 7 to 1, respectively.

1: Set to RORA VXI interrupt for corresponding level.
0: Set to ROAK VXI interrupt for corresponding level.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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VXIintHandler
Waits until a VXI interrupt occurs on the specified level(s).

levels is a bit vector that specifies which level to poll.
1: Set.
0: Do not set.

Bits O to 6 correspond to VXI interrupt levels 1 to 7, respectively.

timeout specifies the number of milliseconds to wait for the interrupt.
–1 Forever.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

controller  specifies the logical address of controller interrupting.

level specifies the received VXI interrupt level.

statusID specifies the status/ID obtained during IACK cycle. (If statusID 
is a 16-bit VXI IACK value, it may be equivalent to a VXI signal.)

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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VXI Trigger VIs

This chapter describes the VIs that control triggers, a backplane feature
VXI adds to the VME standard. You can use four basic protocols (SYN
ASYNC, SEMI-SYNC, and START/STOP) for device synchronization,
for stepping through tests, or for a command path. The Trigger VIs fall i
four categories:

• Source Trigger VIs act as a standard interface for asserting (sourc
TTL and ECL triggers, as well as for detecting acknowledgements
from accepting devices.

• Acceptor Trigger VIs act as a standard interface for sensing 
(accepting) TTL and ECL triggers, as well as for sending 
acknowledgements back to the sourcing device.

• Map Trigger VIs act as configuration tools for multiframe and loca
support for VXI triggers.

• Trigger Configuration VIs configure not only the general settings o
the trigger inputs and outputs, but also the TIC counter and tick tim

The actual capabilities of specific systems are based on the triggering
capabilities of the hardware devices involved (both the sourcing and 
accepting devices).

Locating VXI Trigger VIs in LabVIEW
Select Windows»Show Diagram to go to the block diagram in LabVIEW.
From the Functions palette, choose Instrument I/O»VXI»VXI Trigger 
to locate the VXI Trigger VIs in LabVIEW.

Finding Help Online for VXI Trigger VIs
You can find helpful information about individual VIs online by using th
LabVIEW Help window. Open the Help window by choosing Help»Show 
Help in LabVIEW. When you place the cursor on a VI icon, the wiring 
diagram and parameter names for that VI appear in the Help window.
bVIEW VXI VI Reference Manual
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You also can double-click the VI to open the front panel. When the He
window is open, you can get more information on each parameter by 
placing the cursor over the corresponding control or indicator on the V
front panel.

Handling Errors
The NI-VXI VIs use the LabVIEW error cluster method for handling 
errors. Each VI has error in and error out terminals. See Appendix A, Error 
Codes, for information on how the error codes relate to the previous sta
codes used by the NI-VXI VIs and a description of error in  and error out  
parameters.

VXI Trigger VI Descriptions

AcknowledgeTrig
Acknowledges the specified TTL/ECL or external (GPIO) trigger on the specified contro

The TTL/ECL trigger interrupt handler is called after an TTL/ECL trigger is sensed. If th
sensed protocol requires an acknowledge (ASYNC or SEMI-SYNC protocols), the 
application should call the AcknowledgeTrig VI after performing any device-dependent
operations. If you configured a trigger line using the TrigAssertConfig VI to participate 
external (GPIO) SEMI-SYNC acknowledging, you can use the AcknowledgeTrig VI to 
manually acknowledge a pending external SEMI-SYNC trigger.

controller  is the controller on which to acknowledge the trigger interrup

line is the TTL, ECL, or external trigger line to acknowledge. See the 
following table for the meaning of the values.

Value Trigger Lines

0 to7 TTL trigger lines 0 to7

8 to13 ECL trigger lines 0 to5

40 to49 External source/destination (GPIO 0 to9)
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error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

DisableTrigSense
Disables the sensing of the specified TTL/ECL trigger line, counter, or tick timer that w
enabled by the EnableTrigSense VI.

controller  is the controller on which to disable sensing.

line is the trigger line to disable sensing.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

Value Trigger Lines

0 to7 TTL trigger lines 0 to7

8 to13 ECL trigger lines 0 to5

50 TIC counter*

60 TIC TICK timers*

*Only with controllers that have the TIC ASIC (Application Specific Integrated Circuit).
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EnableTrigSense
Enables the sensing of the specified TTL/ECL trigger line or starts up the counter or tick 
for the specified protocol.

When the protocol is sensed, the corresponding trigger interrupt handler will be invoke
order to start up the counter or tick timers, you must first call either the TrigCntrConfig 
TrigTickConfig VIs, respectively.

controller  is the controller on which to enable sensing.

line is the trigger line to enable sensing. See the following table for the
meaning of the values.

prot  specifies the protocol to use.
2: START
3: STOP
4: SYNC
5: SEMI-SYNC
6: ASYNC

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

Value Trigger Lines

0 to7 TTL trigger lines 0 to7

8 to13 ECL trigger lines 0 to5

50 TIC counter*

60 TIC TICK timers*

*Only with controllers that have the TIC ASIC.
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GetTrigHandler
Returns the address of the current TTL/ECL trigger, counter, or tick timer interrupt han
for a specified trigger source.

line is the TTL, ECL trigger line or counter/tick. See the following table f
the meaning of the values.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

func is a pointer to the current trigger interrupt handler for a specified 
trigger line to be used with the SetTrigHandler VI.

0: Invalid line or no hardware support.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

Value Trigger Lines

0 to7 TTL trigger lines 0 to7

8 to13 ECL trigger lines 0 to5

50 TIC counter*

60 TIC TICK timers*

*Only with controllers that have the TIC ASIC.
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MapTrigToTrig
Maps the specified TTL, ECL, Star X, Star Y, external connection (GPIO), or miscellane
signal line to another.

The support actually present is completely hardware dependent and is reflected in the
status and in hardware-specific documentation.

controller  is the controller on which to map signal lines.

srcTrig  is the source line to map to destination line.

dstTrig  is the destination line to map from source line. See the followin
table for the meaning of the values. (Star X and Star Y are not current
supported lines.)

Value Source or Destination

0 to7 TTL trigger lines 0 to 7

8 to13 ECL trigger lines 0 to5

14 to26 Star X lines 0 to12

27 to39 Star Y lines 0 to12

40 to49 External source/destination (GPIO 0 to 9)

40 Front panel In (connector 1)

41 Front panel Out (connector 2)

42  ECL bypass from front panel

43 Connection to EXTCLK input pin

44 to 49 Hardware-dependent GPIO 4 to 9

50 TIC counter pulse output (TCNTR)*

51 TIC counter finished output (GCNTR)*

60 TIC TICK1 tick timer output*
LabVIEW VXI VI Reference Manual 11-6 © National Instruments Corporation
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error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

mode is the signal conditioning mode.
0: No conditioning.

Bits 0 through 3 have the following conditioning effects.

All other values are reserved for future expansion.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

61 TIC TICK2 tick timer output*

*Only with controllers that have the TIC ASIC.

Bit Conditioning Effect

0 Synchronize with next CLK edge.*

1 Invert signal polarity

2 Pulse stretch to one CLK minimum.*

3 Use EXTCLK (not CLK10) for conditioning

*Only with controllers that have the TIC ASIC.

Value Source or Destination
© National Instruments Corporation 11-7 LabVIEW VXI VI Reference Manual
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SetTrigHandler
Replaces the current TTL/ECL trigger, counter, or tick timer interrupt handler for a spec
trigger source with the specified function, func.

lines is a bit vector of trigger lines.
1: Set.
0: Do not set.

func is a pointer to the new trigger interrupt handler returned from the 
GetTrigHandler VI.

0: DefaultTrigHandler. (Calls AcknowledgeTrig if the interrupt is
received while enabled to sense a trigger line using
EnableTrigSense.)

1: DefaultTrigHandler2. (Does not call AcknowledgeTrig. The user
responsible for calling AcknowledgeTrig.)

3: LabVIEW Occurrence Handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

Bit Trigger Lines

0 to7 TTL lines 0 to7

8 to13 ECL lines 0 to5

14 TIC counter*

15 TIC TICK timers*

*Only with controllers that have the TIC ASIC.
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SrcTrig
Sources the specified protocol on the specified TTL, ECL, or external trigger line on th
specified controller.

controller  is the controller on which to source the trigger line.

line is the trigger line to source. See the following table for the meaning
the values.

prot  specifies the protocol to use.
0: ON.
1: OFF.
2: START.
3: STOP.
4: SYNC.
5: SEMI-SYNC.
6: ASYNC.
7: SEMI-SYNC and wait for acknowledge.
8: ASYNC and wait for acknowledge.
FFFFH: Abort previous acknowledge pending (5 and 6).

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

timeout specifies the timeout value in milliseconds.

Value Trigger Lines

0 to7 TTL trigger lines 0 to 7

8 to13 ECL trigger lines 0 to 5

40 to49 External source/destination (GPIO 0 to9)

50 TIC counter*

60 TIC TICK timers

*Only with controllers that have the TIC ASIC.
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error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

TrigAssertConfig
Configures the specified TTL/ECL trigger line assertion method. TTL/ECL triggers can
(re-) synchronized to CLK10 on a per line basis. You can globally select all TTL/ECL trig
lines to synchronize to either the rising or falling edge of CLK10. In addition, you can spe
a trigger line specified to partake in SEMI-SYNC accepting with external acknowledge

controller  is the controller on which to configure assertion mode.

line is the trigger line to configure. See the following table for the mean
of the values.

mode specifies the configuration mode.

Value Trigger Lines

0 to7 TTL trigger lines 0 to7

8 to13 ECL trigger lines 0 to5

FFFFH General assertion configuration (all lines).

Bit Specific Line Configuration Modes

0 1: Synchronize falling edge of CLK10.
0: Synchronize rising edge of CLK10.

Bit General Configuration Modes

1 1: Pass trigger through asynchronously.
0: Synchronize with next CLK10 edge.

2 1: Participate in SEMI-SYNC with
external trigger acknowledge protocol.
0: Do not participate.
LabVIEW VXI VI Reference Manual 11-10 © National Instruments Corporation
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All other values are reserved for future expansion.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

TrigCntrConfig
Configures TIC chip internal 16-bit counter. Call SrcTrig or EnableTrigSense to actually 
the counter. The input can be any trigger line, CLK10, or the EXTCLK connection. This
works only with controllers that have the TIC ASIC.

The counter has two outputs: TCNTR (one 100-nsec pulse per input edge) and GCNT
(unasserted until count goes from 1 to 0, then asserted until counter reloaded or reset)
the MapTrigToTrig VI to map TCNTR to any number of the TTL or ECL trigger lines and
map GCNTR to any number of the external (GPIO) lines.

controller  is the controller on which to configure the TIC counter.

mode is the configuration mode.
0: Initialize the counter.
2: Reload the counter leaving enabled.
3: Disable/abort any count in progress

source is the trigger line to configure as input to counter.

count specifies the number of input pulses to count before terminating

Value Trigger Lines

0 to7 TTL trigger lines 0 to7

8 to13 ECL trigger lines 0 to5

70 CLK10

71 EXTCLK connection
© National Instruments Corporation 11-11 LabVIEW VXI VI Reference Manual
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error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

TrigExtConfig
Configures the external trigger (GPIO) lines. You can feed back the external trigger line
use in the crosspoint switch output. You can assert the external trigger lines high or low
leave them unconfigured (tristated) for use as a crosspoint switch input. If the external tr
lines are not feedback, you can invert the external input before mapping it to a trigger l

controller  is the controller on which to configure the external connectio

extline is the trigger line to configure. See the following table for the 
meaning of the values.

Value Trigger Lines

40 to49 External source/destination (GPIO 0 to9)

40 Front panel In (connector 1)

41 Front panel Out (connector 2)

42 ECL bypass from front panel

43 EXTCLK

44 to49 Hardware-dependent GPIO 4 to9
LabVIEW VXI VI Reference Manual 11-12 © National Instruments Corporation
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mode specifies the configuration mode.

All other values are reserved for future expansion.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

TrigHandler
Waits until a trigger interrupt occurs on the specified line(s).

lines is a bit vector that specifies which lines to poll.
1: Set.
0: Do not set.

Bit Configuration Modes

0 1: Feed back any line mapped as input into the 
crosspoint switch.
0: Drive input to external (GPIO) pin.

1 1: Assert input (regardless of feedback).
0: Leave input unconfigured.

2 1: If assertion selected, assert low.
0: If assertion selected, assert high.

3 1: Invert external input (not feedback).
0: Pass external input unchanged.

Bit Trigger Lines

0to7 TTL lines 0 to7

8to13 ECL lines 0 to5
© National Instruments Corporation 11-13 LabVIEW VXI VI Reference Manual
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timeout specifies the number of milliseconds to wait for the interrupt.
–1: Forever.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

controller  is the controller form which the trigger interrupt is received.

line is the trigger line on which the trigger interrupt was received. See 
following table for the meaning of the values.

type is a bit vector that specifies the type of trigger interrupt.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

14 TIC counter

15 TIC TICK timers

Value Trigger Lines

0to7 TTL lines 0 to7

8to13 ECL lines 0 to5

50 TIC counter

60 TIC TICK timers

Bit Trigger Lines

0 1: Source trigger acknowledged.

0: Trigger sensed.

2 1: Assertion edge overrun occurred.

3 1: Unassertion edge overrun occurred.

4 1: Pulse stretch overrun occurred.

5 1: Error summary (2,3,4:1).

Bit Trigger Lines
LabVIEW VXI VI Reference Manual 11-14 © National Instruments Corporation
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TrigTickConfig
Configures TIC chip internal dual 5-bit tick timers. Call the SrcTrig or EnableTrigSense
to actually start the tick timers. The SrcTrig VI inhibits the TICK1 output from generating 
timer interrupts. The EnableTrigSense VI enables the TICK1 output to generate tick tim
interrupts. The input can be any external (GPIO) line, CLK10, or the EXTCLK connect
You can map the two tick timer outputs, TICK1 and TICK2, to any number of TTL/ECL
trigger lines. In addition, you can map the TICK2 output to any number of external (GP
lines. This VI works only with controllers that have the TIC ASIC.

tcount2 is the number of input pulses (as a power of two) to count befo
asserting TICK2 output.

controller  is the controller on which to configure the TIC chip dual 5-bi
tick timers.

mode is the configuration mode.
0: Initialize the tick timers (rollover mode).
1: Initialize the tick timers (non-rollover mode).
2: Reload the tick timers leaving enabled.
3: Disable/abort any count in progress.

source is the trigger line to configure as input to counter. See the followi
table for the meaning of the values.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

Value Configuration Modes

40 to49 External source/destination (GPIO 0 to9)

40 Front panel in (connector 1)

41 Front panel out (connector 2)

70 CLK10

71 EXTCLK connection
© National Instruments Corporation 11-15 LabVIEW VXI VI Reference Manual



Chapter 11 VXI Trigger VIs

re 
 

rror 

ing 
tcount1 is the number of input pulses (as a power of two) to count befo
asserting TICK1 output (and terminating the tick timer if configured for
non-rollover mode).

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

UnMapTrigToTrig
Unmaps the specified TTL, ECL, Star X, Star Y, external connection (GPIO), or 
miscellaneous signal line that was mapped to another line using the MapTrigToTrig VI.

controller  is the controller on which to unmap signal lines.

srcTrig  is the source line to unmap from destination line.

dstTrig  is the destination line mapped from source line. See the follow
table for the meaning of the values.

Value Source or Destination

0 to7 TTL trigger lines 0 to7

8 to13 ECL trigger lines 0 to5

14 to26 Star X lines 0 to12

27 to39 Star Y lines 0 to12

40 to49 External source/destination (GPIO 0 to9)

40 Front panel In (connector 1)

41 Front panel Out (connector 2)

42 ECL bypass from front panel

43 Connection to EXTCLK input pin

44 to49 Hardware-dependent GPIOs 4 to9

50 TIC counter pulse output (TCNTR)*
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error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

WaitForTrig
Waits for the specified trigger line to be sensed on the specified controller for the spec
time. The EnableTrigSense VI must be called to sensitize the hardware to the particula
trigger protocol to be sensed.

controller  is the controller on which to wait for trigger.

line is the trigger line to wait on. See the following table for the meaning
the values.

timeout specifies the timeout value (in milliseconds).

51 TIC counter finished output (GCNTR)*

60 TIC TICK1 tick timer output*

61 TIC TICK2 tick timer output*

*Only with controllers that have the TIC ASIC.

Value Trigger Lines

0 to7 TTL trigger lines 0 to7

8 to13 ECL trigger lines 0 to5

50 TIC counter*

60 TIC TICK1 tick timer*

*Only with controllers that have the TIC ASIC.

Value Source or Destination
© National Instruments Corporation 11-17 LabVIEW VXI VI Reference Manual
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error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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System Interrupt Handler VIs

This chapter describes the System Interrupt Handler VIs. You can use t
VIs to handle miscellaneous system conditions that can occur in the V
environment, such as Sysfail, ACfail, BusError, Sysreset, or Soft Rese
conditions. The NI-VXI software interface can handle these system 
conditions for the application through the use of default interrupt servi
routines.

The NI-VXI software handles all system interrupt handlers in the same
manner. Each type of interrupt has its own specified default handler, wh
is installed when InitVXIlibrary initializes the NI-VXI software. All 
system interrupt handlers are initially disabled (except for BusError). T
corresponding enable function for each handler must be called in orde
invoke the default handler.

Locating System Interrupt Handler VIs in LabVIEW
Select Windows»Show Diagram to go to the block diagram in LabVIEW.
From the Functions palette, choose Instrument I/O»VXI»System 
Interrupt Handler to locate the System Interrupt Handler VIs in 
LabVIEW.

Finding Help Online for System Interrupt Handler VIs
You can find helpful information about individual VIs online by using th
LabVIEW Help window. Open the Help window by choosing Help»Show 
Help in LabVIEW. When you place the cursor on a VI icon, the wiring 
diagram and parameter names for that VI appear in the Help window.

You also can double-click the VI to open the front panel. When the He
window is open, you can get more information on each parameter by 
placing the cursor over the corresponding control or indicator on the V
front panel.
bVIEW VXI VI Reference Manual
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Handling Errors
The NI-VXI VIs use the LabVIEW error cluster method for handling 
errors. Each VI has error in and error out terminals. See Appendix A, Error 
Codes, for information on how the error codes relate to the previous sta
codes used by the NI-VXI VIs and a description of error in  and error out  
parameters.

System Interrupt Handler VI Descriptions

ACfailHandler
Waits until an ACfail interrupt occurs.

timeout specifies the number of milliseconds to wait for the interrupt.
–1: Forever.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

controller  specifies the logical address of controller interrupting.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

AssertSysreset
Asserts the SYSRESET* signal in the mainframe specified by controller.

controller  specifies the logical address of the mainframe extender on 
which to assert SYSRESET*.

–1: From the local CPU or first extended controller.
–2: All extenders.
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mode specifies the mode of execution.
0: Do not disturb original configuration.
1: Force link between SYSRESET* and local reset (SYSRESET*

resets local CPU).
2: Break link between SYSRESET* and local reset (SYSRESET*

does not reset local CPU).

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

BusErrorHandler
Waits until a bus error occurs.

timeout specifies the number of milliseconds to wait for the interrupt.
–1: Forever.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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DisableACfail
Desensitizes the local CPU from interrupts generated from ACfail conditions on the 
embedded CPU’s VXIbus backplane, or from the specified extended controller’s VXI 
backplane (if external CPU).

controller  specifies the logical address of the mainframe extender to 
disable.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

DisableSoftReset
Disables the local Soft Reset interrupt being generated from a write to the reset bit of the
CPU control register.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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DisableSysfail
Desensitizes the local CPU from interrupts generated from Sysfail conditions on the 
embedded CPU’s VXIbus backplane or from the specified extended controller’s VXI 
backplane (if external CPU).

controller  specifies the logical address of the mainframe extender to 
disable.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

DisableSysreset
Desensitizes the application from Sysreset interrupts generated from the embedded C
VXIbus backplane or from the specified extended controller's VXI backplane (if externa
CPU).

controller  specifies the logical address of the mainframe extender to 
disable.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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EnableACfail
Sensitizes the local CPU to interrupts generated from ACfail conditions on the embedd
CPU’s VXIbus backplane or from the specified controller’s VXI backplane (if external CP

controller  specifies the logical address of the mainframe extender to 
enable.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

EnableSoftReset
Enables the local Soft Reset interrupt being generated from a write to the Reset bit of the
CPU Control register.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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EnableSysfail
Sensitizes the local CPU to interrupts generated from Sysfail conditions on the embed
CPU’s VXIbus backplane or from the specified extended controller’s VXI backplane (if 
external CPU).

controller  specifies the logical address of the mainframe extender to 
enable.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

EnableSysreset
Sensitizes the local CPU to Sysreset interrupts generated from the embedded CPU’s V
backplane or from the specified extended controller’s VXI backplane (if external CPU).

controller  specifies the logical address of the mainframe extender to 
enable.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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GetACfailHandler
Returns the address of the current ACfail interrupt handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

func is the pointer to the current ACfail interrupt handler.
0: ACfail interrupts not supported.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

GetBusErrorHandler
Returns the address of the current user Bus Error interrupt handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

func is the pointer to the current Bus Error interrupt handler.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
LabVIEW VXI VI Reference Manual 12-8 © National Instruments Corporation



Chapter 12 System Interrupt Handler VIs

ee 

rror 

ee 

rror 
GetSoftResetHandler
Returns the address of the current Soft Reset interrupt handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

func is the pointer to the current Soft Reset interrupt handler.
0: Soft Reset interrupts not supported.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

GetSysfailHandler
Returns the address of the current Sysfail interrupt handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

func is the pointer to the current Sysfail interrupt handler.
0: Sysfail interrupts not supported.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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GetSysresetHandler
Returns the address of the current SYSRESET* interrupt handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

func is the pointer to the current SYSRESET* interrupt handler.
0: SYSRESET* interrupts not supported.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

SetACfailHandler
Replaces the current ACfail interrupt handler with a specified handler.

func points to the new ACfail interrupt handler.
0: Set to DefaultACfailHandler.
3: LabVIEW occurrence handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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SetBusErrorHandler
Replaces the current Bus Error handler with a specified handler.

func points to the new Bus Error interrupt handler.
0: Set to DefaultBusErrorHandler.
3: LabVIEW occurrence handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

SetSoftResetHandler
Replaces the current Soft Reset interrupt handler with a specified handler.

func points to the new Soft Reset interrupt handler.
0: Set to DefaultSoftResetHandler.
3: LabVIEW occurrence handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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SetSysfailHandler
Replaces the current Sysfail interrupt handler with a specified function, func.

func is a pointer to the new Sysfail handler.
0: DefaultSysfailHandler sets only the Sysfail Inhibit bit in the 

Control register of the failed Servant.
1: DefaultSysfailHandler2 sets the Reset bit along with the Sysfa

Inhibit bit in the Control register of the failed Servant.
3: LabVIEW occurrence handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

SetSysresetHandler
Replaces the current SYSRESET* interrupt handler with a specified handler, func.

func is the pointer to the new SYSRESET* interrupt handler.
0: Set to DefaultSysresetHandler.
3: LabVIEW occurrence handler.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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SoftResetHandler
Waits until a SoftReset interrupt occurs.

timeout specifies the number of milliseconds to wait for the interrupt.
–1: Forever.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

SysfailHandler
Waits until a Sysfail interrupt occurs.

timeout specifies the number of milliseconds to wait for the interrupt.
–1: Forever.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

controller  specifies the logical address of controller interrupting.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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SysresetHandler
Waits until a SYSRESET* interrupt occurs.

timeout specifies the number of milliseconds to wait for the interrupt.
–1: Forever.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

controller  specifies the logical address of controller interrupting.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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VXIbus Extender VIs

This chapter describes the VXIbus Extender VIs. The NI-VXI software
interface fully supports the standard VXIbus extension method presen
in the VXIbus Mainframe Extender Specification. When the National 
Instruments Resource Manager completes its configuration, all defaul
transparent extensions are complete. You can use these VIs to dynam
change these extensions if your application has such a requirement.

The transparent extensions include extensions of VXI Interrupt, TTL 
trigger, ECL trigger, Sysfail, ACfail, and Sysreset VXIbus signals for 
multi-mainframe systems. You can use these VIs to dynamically chan
these extensions if your application has such requirements. Usually, th
application will never need to change the default settings. Consult you
utilities manual on how to use vxiedit, the NI-VXI resource program edit
to change the default extender settings.

Locating VXIbus Extender VIs in LabVIEW
Select Windows»Show Diagram to go to the block diagram in LabVIEW.
From the Functions palette, choose Instrument I/O»VXI»VXIbus 
Extender to locate the VXIbus Extender VIs in LabVIEW.

Finding Help Online for VXIbus Extender VIs
You can find helpful information about individual VIs online by using th
LabVIEW Help window. Open the Help window by choosing Help»Show 
Help in LabVIEW. When you place the cursor on a VI icon, the wiring 
diagram and parameter names for that VI appear in the Help window.

You also can double-click the VI to open the front panel. When the He
window is open, you can get more information on each parameter by 
placing the cursor over the corresponding control or indicator on the V
front panel.
bVIEW VXI VI Reference Manual
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Handling Errors
The NI-VXI VIs use the LabVIEW error cluster method for handling 
errors. Each VI has error in and error out terminals. See Appendix A, Error 
Codes, for information on how the error codes relate to the previous sta
codes used by the NI-VXI VIs and a description of error in  and error out  
parameters.

VXIbus Extender VI Descriptions

MapECLtrig
Maps the specified ECL trigger lines for the specified mainframe in the specified direct
(into or out of the mainframe).

extender specifies the mainframe extender for which to map ECL lines

lines is a bit vector of ECL trigger lines.
1: Enable for appropriate line.
0: Disable for appropriate line.

Bits 5to 0 correspond to ECL lines 5to 0, respectively.

directions is a bit vector of directions for ECL trigger lines.
1: Into the mainframe.
0: Out of the mainframe.

Bits 5to0 correspond to ECL lines 5to 0, respectively.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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MapTTLtrig
Maps the specified TTL trigger lines for the specified mainframe in the specified directi
(into or out of the mainframe).

extender specifies the mainframe extender for which to map TTL lines

lines is a bit vector of TTL trigger lines.

Bits 7to 0 correspond to TTL lines 7to 0, respectively.
1: Enable for appropriate line.
0: Disable for appropriate line.

directions is a bit vector of directions for TTL trigger lines.

Bits 7to 0 correspond to TTL lines 7to 0, respectively.
1: Into the mainframe.
0: Out of the mainframe.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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MapUtilBus
Maps the specified VXI utility bus signal for the specified mainframe into and out of the
mainframe. The utility bus signals include Sysfail, ACfail, and SYSRESET*.

extender specifies the mainframe extender for which to map utility bus
signals.

modes is a bit vector of utility bus signals corresponding to the utility bu
signals.

1: Enable for the corresponding signal and direction.
0: Disable for the corresponding signal and direction.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.

Bit Utility Bus Signal and Direction

5 ACfail into the mainframe

4 ACfail out of the mainframe

3 Sysfail into the mainframe

2 Sysfail out of the mainframe

1 SYSRESET* into the mainframe

0 SYSRESET* out of the mainframe
LabVIEW VXI VI Reference Manual 13-4 © National Instruments Corporation
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MapVXIint
Maps the specified VXI interrupt levels for the specified mainframe in the specified direc
(into or out of the mainframe).

extender specifies the mainframe extender for which to map VXI interru
levels.

levels is a bit vector of VXI interrupt levels.

Bits 6 to 0 correspond to VXI interrupt levels 7to1, respectively.
1: Enable for appropriate level.
0: Disable for appropriate level.

directions is a bit vector of directions for VXI interrupt levels.

Bits 6 to 0 correspond to VXI interrupt levels 7to1, respectively.
1: Into the mainframe.
0: Out of the mainframe.

error in  describes error conditions occurring before the VI executes. S
Appendix A, Error Codes, for more information on error clusters and 
specific errors.

error out contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise, e
out describes the error status of this VI. See Appendix A, Error Codes, for 
specific error information.
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Error Codes

This appendix describes the error codes returned by LabVIEW VXI VIs.

In previous versions of LabVIEW, the VXI VIs returned a status value that indicated how
VI completed. The new VXI VIs use LabVIEW error clusters to track status information
the VIs. The error codes used by these VIs are not the same as the previous status va

In most cases the new error codes have been formed by adding a constant offset to th
status values. The Ecode VI that is used to carry out this conversion is shown below.

This VI along with the SubVIs it uses are available in the VXI directory for anyone that 
interested in how the conversion process is performed.

A new VI, the Oldcode VI, can convert a new error cluster to an old status value. This V
available in the Vi.lib\Inst\VXI  directory. It returns the status both as an integer and a
16-element Boolean array.

Status is a 16-element Boolean array corresponding to the old status v
indicated by the error code in the input error cluster.

Status is an integer error code corresponding to the old status value 
indicated by the error code in the input error cluster.

error in  describes error conditions before the VI executes. If an error 
already occurred, the VI returns the value of the error in cluster in error 
Reference Manual
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Error Cluster Descriptions
The error in  cluster contains the following information:

status is TRUE if an error occurred. If the status is TRUE the VI does n
perform any operations.

code is the error code number identifying an error. A value of 0 means
error, a negative value means a fatal error, and a positive value is a 
warning/status report. The codes used by the VIs in each chapter are 
below.

source identifies where an error occurred. The source string is usually 
name of the VI that produced the error.

error out  contains error information. If the error in cluster indicated an 
error, the error out cluster contains the same information. Otherwise th
error out cluster describes the status of this VI.

System Configuration and VXI Library Initialization VIs

Note The InitVXIlibrary and CloseVXIlibrary VIS do not use these codes. The 
InitVXIlibrary codes are shown in the following list.

Note The CloseVXIlibrary codes are shown in the following list.

–3201 Device not found or device already exists.

–3202 Invalid field or logical address out of range 0 to 511.

–3203 Dynamic memory allocation failure.

–3299 NI-VXI library system error.

–3001 NI-VXI library initialization failed.

–3099 NI-VXI library system error.

3001 VXI library already initialized (repeat call).

3002 NI-VXI library successfully initialized, but the 
Resource Manager failed to run successfully.

–3101 NI-VXI library termination failed.

–3199 NI-VXI library system error.

3101 Success; previous InitVXIlibrary calls still pending.
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–3301 Invalid logical address.

–3302 Invalid abortop.

–3303 Error occurred attempting to open or access the 
specified file.

–3304 Timeout occurred before command was sent.

–3305 Timeout occurred before response was received.

–3307 Forced user abort occurred during transfer.

–3308 Invalid logical address.

–3309 Multiple query error occurred during transfer.

–3310 Bus error occurred during transfer.

–3311 Timeout occurred during transfer.

–3312 Device did not recognize the command.

–3313 Read protocol error.

–3314 Device reported an input protocol error during transfer.

–3315 Device reported an output protocol error during transfer.

–3316 Violation of raw read protocol occurred during transfer.

–3317 Violation of raw write protocol occurred during transfer.

–3318 Handler timed out.

3303 Transfer completed successfully, and at least one of the 
specified termination conditions was received.

3305 Transfer completed successfully, and the specified 
number of bytes were received.

3307 Transfer completed successfully, the specified number 
of bytes were read, and at least one of the specified 
termination conditions was received.

3308 Transfer was aborted because the device was not ready. 

3319 Transfer completed successfully, and the END bit was 
received.

3323 Transfer completed successfully, the specified number 
of bytes were read, and the END bit was received.

3335 Transfer completed successfully, and the termination 
character was received.

3339 Transfer completed successfully, the specified number 
of bytes were read, and the termination character was 
received.

3351 Transfer completed successfully, and both the 
termination character and the END bit were received.
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Appendix A Error Codes

eek 
Word Serial Servant Protocol VIs

Low-Level VXIbus Access VIs

Note The VXIpeek and VXIpoke VIs do not use these codes. The codes used by VXIp
and VXIpoke are shown in the following list.

3355 Transfer completed successfully, the specified number 
of bytes were read, and both the termination character 
and the END bit were received.

–3401 Word Serial servant VI not supported.

–3402 Unable to perform operation (operation in progress).

–3403 Handler timed out.

–3499 NI-VXI library system error.

3401 Operation posted successfully, will begin after 
WSSenable or proterr  ignored because previous error 
was pending.

–3501 Invalid window number or no hardware support.

–3502 Invalid input parameter.

–3503 Invalid field or address.

–3505 Byte order not supported.

–3506 Specified offset is not accessible from this hardware.

–3507 Privilege not supported.

–3508 Timeout (window still in use; must use 
UnMapVXIAddress).

–3509 Window does not have owner access.

–3510 Base address change is not supported.

–3599 NI-VXI library system error.

3501 Window accessor was released, but the hardware 
window is still mapped due to multiple users or byte 
order set the same for all windows.

–3601 Bus error occurred during transfer.

–3699 NI-VXI library system error.
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Appendix A Error Codes
High-Level VXIbus Access VIs

Local Resource Access VIs

Shared Memory Access VIs

–3601 Bus error occurred during access.

–3602 Invalid access, source or destination parameters.

–3603 Invalid register or address.

–3604 Invalid access width.

–3605 Byte order not supported.

–3606 Specified offset or address is not accessible from this 
hardware.

–3607 Privilege not supported.

–3608 Timeout; DMA abort error.

–3609 Width not supported.

–3699 NI-VXI library system error.

–3701 Unsupported VI; not a slot 0 device or bus error 
occurred during access.

–3703 Invalid address.

–3704 Invalid access width.

–3709 Access with not supported.

–3799 NI-VXI library system error.

–3801 Memory operation failed.

–3802 Local CPU is A16 only.

–3805 Invalid direction.

–3899 NI-VXI library system error.

3801 Memory allocation successful, but memory must be 
accessed using VXImemCopy.
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Appendix A Error Codes
VXI Signal VIs

VXI Interrupt VIs

VXI Trigger VIs

–3901 Invalid logical address or specified signal could not be 
added/removed due to queue full/empty condition.

–3902 Invalid logical address, or timeout occurred while 
waiting for a signal to arrive that matches the specified 
signal mask.

–3903 Handler timed out.

–3999 NI-VXI library system error.

3901 Signal queue full, will enable after a SignalDeq.

–4001 No hardware support for this operation or invalid 
interrupt level.

–4002 Invalid controller.

–4003 Invalid interrupt level.

–4004 Bus error occurred during IACK cycle.

–4005 VXI interrupt still pending from previous AssertVXIint 
VI or invalid modes.

–4006 Handler timed out.

–4099 NI-VXI library system error.

4001 Signal queue full, will enable interrupts after a 
SignalDeq.

–4101 Unsupported VI; no hardware support.

–4102 Invalid controller.

–4103 Invalid line or protocol.

–4104 Line not supported.

–4105 Protocol not supported.

–4106 Timeout occurred.

–4107 Line already in use.

–4108 SrcTrig not supported.

–4109 DestTrig not supported.

–4110 Invalid configuration.

–4111 Already mapped, must use UnMapTrigToTrig.
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Appendix A Error Codes
System Interrupt Handler VIs

VXIbus Extender VIs

–4112 Line or counter not configured or initialized.

–4115 Previous operation incomplete or previous tick 
configured and enabled.

–4116 Previous acknowledge still pending.

–4117 No trigger sensed.

–4118 Line not configured for external SEMI_SYNC.

–4119 Handler timed out.

–4199 NI-VXI library system error.

–4201 No hardware support for this operation or interrupt type.

–4202 Invalid controller.

–4203 Handler timed out.

–4299 NI-VXI library system error.

–4301 Unsupported VI; no hardware support.

–4302 Invalid extender.

–4399 NI-VXI library system error.
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Customer Communication

For your convenience, this appendix contains forms to help you gather the information necessa
to help us solve your technical problems and a form you can use to comment on the product 
documentation. When you contact us, we need the information on the Technical Support Form
the configuration form, if your manual contains one, about your system configuration to answer
questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to
provide the information you need. Our electronic services include a bulletin board service, an FT
a fax-on-demand system, and e-mail support. If you have a hardware or software problem, first 
electronic support systems. If the information available on these systems does not answer you
questions, we offer fax and telephone support through our technical support centers, which are
by applications engineers. 

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of
and documents to answer most common customer questions. From these sites, you can also d
the latest instrument drivers, updates, and example programs. For recorded instructions on how
the bulletin board and FTP services and for BBS automated information, call 512 795 6990. Yo
access these services at:

United States: 512 794 5422
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom: 01635 551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France: 01 48 65 15 59
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com , as anonymous  and use 
your Internet address, such as joesmith@anywhere.com , as your password. The support files and
documents are located in the /support  directories.
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Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a
range of technical information. You can access Fax-on-Demand from a touch-tone telephone a
512 418 1111.

E-Mail Support (Currently USA Only)
You can submit technical support questions to the applications engineering team through e-mai
Internet address listed below. Remember to include your name, address, and phone number so
contact you with solutions and suggestions. 

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technic
support number for your country. If there is no National Instruments office in your country, cont
the source from which you purchased your software to obtain support.

Country Telephone Fax
Australia 03 9879 5166 03 9879 6277
Austria 0662 45 79 90 0 0662 45 79 90 19
Belgium 02 757 00 20 02 757 03 11
Brazil 011 288 3336 011 288 8528
Canada (Ontario) 905 785 0085 905 785 0086
Canada (Quebec) 514 694 8521 514 694 4399
Denmark 45 76 26 00 45 76 26 02
Finland 09 725 725 11 09 725 725 55
France 01 48 14 24 24 01 48 14 24 14
Germany 089 741 31 30 089 714 60 35
Hong Kong 2645 3186 2686 8505
Israel 03 6120092 03 6120095
Italy 02 413091 02 41309215
Japan 03 5472 2970 03 5472 2977
Korea 02 596 7456 02 596 7455
Mexico 5 520 2635 5 520 3282
Netherlands 0348 433466 0348 430673
Norway 32 84 84 00 32 84 86 00
Singapore 2265886 2265887
Spain 91 640 0085 91 640 0533
Sweden 08 730 49 70 08 730 43 70
Switzerland 056 200 51 51 056 200 51 55
Taiwan 02 377 1200 02 737 4644
United Kingdom 01635 523545 01635 523154
United States 512 795 8248 512 794 5678
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Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, a
the completed copy of this form as a reference for your current configuration. Completing this f
accurately before contacting National Instruments for technical support helps our applications 
engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem
include the configuration forms from their user manuals. Include additional pages if necessary.

Name ______________________________________________________________________

Company ___________________________________________________________________

Address ____________________________________________________________________

___________________________________________________________________________

Fax ( ___ ) ________________Phone ( ___ ) ______________________________________

Computer brand____________ Model ___________________Processor _________________

Operating system (include version number) ________________________________________

Clock speed ______MHz   RAM _____MB Display adapter ________________________

Mouse ___yes   ___no     Other adapters installed___________________________________

Hard disk capacity _____MB Brand______________________________________________

Instruments used _____________________________________________________________

___________________________________________________________________________

National Instruments hardware product model _____________ Revision  ____________________

Configuration _______________________________________________________________

National Instruments software product ___________________ Version  _____________________

Configuration _______________________________________________________________

The problem is: ______________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

List any error messages: _______________________________________________________

___________________________________________________________________________

___________________________________________________________________________

The following steps reproduce the problem: _______________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________
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LabVIEW VXI VI Hardware and Software 
Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each
Complete a new copy of this form each time you revise your software or hardware configuration
use this form as a reference for your current configuration. Completing this form accurately bef
contacting National Instruments for technical support helps our applications engineers answer 
questions more efficiently.

National Instruments Products
Hardware revision ___________________________________________________________

Interrupt level of hardware _____________________________________________________

DMA channels of hardware ____________________________________________________

Base I/O address of hardware ___________________________________________________

Programming choice _________________________________________________________

National Instruments software __________________________________________________

Other boards in system ________________________________________________________

Base I/O address of other boards ________________________________________________

DMA channels of other boards _________________________________________________

Interrupt level of other boards __________________________________________________

Other Products
Computer make and model ____________________________________________________

Microprocessor ______________________________________________________________

Clock frequency or speed ______________________________________________________

Type of video board installed ___________________________________________________

Operating system version ______________________________________________________

Operating system mode _______________________________________________________

Programming language _______________________________________________________

Programming language version _________________________________________________

Other boards in system ________________________________________________________

Base I/O address of other boards ________________________________________________

DMA channels of other boards _________________________________________________

Interrupt level of other boards __________________________________________________



ducts. 

____

____

____

____

____

____

____

____

____

____

____

____

____

____

____

____

____

____

____

____

____
Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our pro
This information helps us provide quality products to meet your needs.

Title: LabVIEWTM VXI VI Reference Manual

Edition Date: January 1998

Part Number: 320557D-01

Please comment on the completeness, clarity, and organization of the manual.

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

Thank you for your help.

Name _____________________________________________________________________

Title ______________________________________________________________________

Company ___________________________________________________________________

Address ____________________________________________________________________

___________________________________________________________________________

E-Mail Address ______________________________________________________________

Phone ( ___ ) __________________________  Fax ( ___ ) ___________________________

Mail to: Technical Publications Fax to: Technical Publications
National Instruments Corporation National Instruments Corporation
6504 Bridge Point Parkway 512 794 5678
Austin, Texas 78730-5039
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Prefix Meanings Value

n- nano- 10–9

m- milli- 10–3

k- kilo- 103

M- mega- 106

G- giga- 109

A16 space One of the VXIbus address spaces. Equivalent to the VME 64 KB sh
address space. In VXI, the upper 16 KB of A16 space is allocated for 
by the configuration registers of the VXI device. This 16 KB region is 
referred to as VXI configuration space.

A24 space One of the VXIbus address spaces. Equivalent to the VME 16 MB stan
address space.

A32 space One of the VXIbus address spaces. Equivalent to the VME 4 GB exte
address space.

access Address modifier codes.

ACFAIL* A VMEbus backplane signal that is asserted when a power failure has
occurred (either AC line source or power supply malfunction), or if it is
necessary to disable the power supply (such as for a high temperature
condition).

address Character code that identifies a specific location (or series of location
memory.

address modifier One of six signals in the VMEbus specification used by VMEbus mas
to indicate the address space and mode (supervisory/nonprivileged, 
data/program/block) in which a data transfer is to take place.
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address space A set of 2n memory locations differentiated from other such sets in 
VXI/VMEbus systems by six signal lines known as address modifiers. n is 
the number of address lines required to uniquely specify a byte locatio
a given space. Valid numbers for n are 16, 24, and 32. 

address window A range of address space that can be accessed from the application
program.

ANSI American National Standards Institute.

array Ordered, indexed set of data elements of the same type.

ASCII American Standard Code for Information Interchange. A 7-bit standard
code adopted to facilitate the interchange of data among various types
data processing and data communications equipment.

ASIC Application Specific Integrated Circuit (a custom chip).

asserted A signal in its active true state.

ASYNC Protocol A two-device, two-line handshake trigger protocol using two consecu
even/odd trigger lines (a source/acceptor line and an acknowledge lin

asynchronous Not synchronized; not controlled by periodic time signals, and theref
unpredictable with regard to the timing of execution of commands.

B

backplane An assembly, typically a printed circuit board, with 96-pin connectors 
signal paths that bus the connector pins. A C-size VXIbus system will h
two sets of bused connectors called the J1 and J2 backplanes. A D-si
VXIbus system will have three sets of bused connectors called the J1,
and J3 backplane.

BERR* Bus Error signal. This signal is asserted by either a slave device or the 
unit (bus timeout unit) when an incorrect transfer is made on the Data
Transfer Bus (DTB). The BERR* signal is also used in VXI for certain 
protocol implementations such as writes to a full Signal register and 
synchronization under the Fast Handshake Word Serial Protocol.

bit Binary digit. The smallest possible unit of data: a two-state, yes/no, 
0/1 alternative. The building block of binary coding and numbering 
systems. Several bits make up a byte.
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bit vector A string of related bits in which each bit has a specific meaning.

buffer Temporary memory/storage location for holding data before it can be 
transmitted elsewhere.

bus master A device that is capable of requesting the Data Transfer Bus (DTB) fo
purpose of accessing a slave device.

bus timeout unit A VMEbus functional module that times the duration of each data tran
on the Data Transfer Bus (DTB) and terminates the DTB cycle if the 
duration is excessive. Without the termination capability of this module
bus master attempt to access a nonexistent slave could result in an 
indefinitely long wait for a slave response.

byte A grouping of adjacent binary digits operated on by the computer as a
single unit. In VXI systems, a byte consists of 8 bits.

byte order How bytes are arranged within a word or how words are arranged wit
longword. Motorola ordering stores the most significant byte (MSB) or
word first, followed by the least significant byte (LSB) or word. Intel 
ordering stores the LSB or word first, followed by the MSB or word. 

C

CLK10 A 10-MHz, ± 100-ppm, individually buffered (to each module slot), 
differential ECL system clock that is sourced from Slot 0 and distributed
Slots 1 through 12 on P2. It is distributed to each slot as a single-sour
single-destination signal with a matched delay of under 8 nsec.

command A directive to a device. In VXI, three types of commands are as follow

In Word Serial Protocol, a 16-bit imperative to a Servant from its 
Commander (written to the Data Low register);

In Shared Memory Protocol, a 16-bit imperative from a client to a serv
or vice versa (written to the Signal register);

In Instrument devices, an ASCII-coded, multi-byte directive.

Commander A Message-Based device which is also a bus master and can control 
more Servants.

communication registers In Message-Based devices, a set of registers that are accessible to 
device's Commander and are used for performing Word Serial Protoco
communications.
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configuration registers A set of registers through which the system can identify a modulede
type, model, manufacturer, address space, and memory requirements
order to support automatic system and memory configuration, the VXI
specification requires that all VXIbus devices have a set of such regist

controller An intelligent device (usually involving a CPU) that is capable of 
controlling other devices.

CR Carriage Return; the ASCII character 0Dh.

D

data transfer bus One of four buses on the VMEbus backplane. The DTB is used by a
master to transfer binary data between itself and a slave device.

default handler Automatically installed at start-up to handle associated interrupt 
conditions; the software can then replace it with a specified handler.

de-referencing Accessing the contents of the address location pointed to by a pointe

DIR Data In Ready

DIRviol Data In Ready violation

DOR Data Out Ready

DORviol Data Out Ready violation

DRAM Dynamic RAM (Random Access Memory); storage that the computer m
refresh at frequent intervals.

E

ECL Emitter-Coupled Logic

embedded controller An intelligent CPU (controller) interface plugged directly into the VXI
backplane, giving it direct access to the VXIbus. It must have all of its 
required VXI interface capabilities built in.

END Signals the end of a data string.

EOS End Of String; a character sent to designate the last byte of a data me
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event signal A 16-bit value written to a Message-Based device's Signal register in w
the most significant bit (bit 15) is a 1, designating an Event (as oppose
a Response signal). The VXI specification reserves half of the Event va
for definition by the VXI Consortium. The other half are user defined.

Extended Class device A class of VXIbus device defined for future expansion of the VXIbus
specification. These devices have a subclass register within their 
configuration space that defines the type of extended device. 

extended controller A mainframe extender with additional VXIbus controller capabilities.

Extended Longword 
Serial Protocol

A form of Word Serial communication in which Commanders Serial 
Protocol Servants communicate with 48-bit data transfers.

external controller In this configuration, a plug-in interface board in a computer is conne
to the VXI mainframe via one or more VXIbus extended controllers. Th
computer then exerts overall control over VXIbus system operations.

F

FHS Fast Handshake; a mode of the Word Serial Protocol which uses the 
VXIbus signals DTACK* and BERR* for synchronization instead of the
Response register bits.

FIFO First In-First Out; a method of data storage in which the first element sto
is the first one retrieved.

G

GPIB General Purpose Interface Bus

GPIO General Purpose Input Output, a module within the National Instrume
TIC chip which is used for two purposes. First, GPIOs are used for 
connecting external signals to the TIC chip for routing/conditioning to t
VXIbus trigger lines. Second, GPIOs are used as part of a crosspoint sw
matrix.

H

handshaking A type of protocol that makes it possible for two devices to synchron
operations.
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hardware context The hardware setting for address space, access privilege, and byte o

high-level Programming with instructions in a notation more familiar to the user t
machine code. Each high-level statement corresponds to several low-
machine code instructions and is machine independent, meaning that
portable across many platforms.

I

IACK Interrupt Acknowledge

IEEE Institute of Electrical and Electronic Engineers

IEEE 1014 The VME specification.

interrupt A signal indicating that the central processing unit should suspend its
current task to service a designated activity. 

interrupt handler A functional module that detects interrupt requests generated by 
interrupters and performs appropriate actions.

interrupter A device capable of asserting interrupts and responding to an interru
acknowledge cycle.

I/O Input/output; the techniques, media, or devices used to achieve 
communication between entities.

L

LabVIEW Laboratory Virtual Instrument Engineering Workbench

LF Linefeed; the ASCII character 0Ah.

logical address An 8-bit number that uniquely identifies the location of each VXIbus 
device’s configuration registers in a system. The A16 register address
device is C000h + Logical Address * 40h.

longword Data type of 32-bit integers.

Longword Serial 
Protocol

A form of Word Serial communication in which Commanders and Serva
communicate with 32-bit data transfers instead of 16-bit data transfers 
the normal Word Serial Protocol.
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low-level Programming at the system level with machine-dependent commands

M

mapping Establishing a range of address space for a one-to-one corresponden
between each address in the window and an address in VXIbus memo

master A functional part of a MXI/VME/VXIbus device that initiates data transfe
on the backplane. A transfer can be either a read or a write.

MB Megabytes of memory.

Memory Class device A VXIbus device that, in addition to configuration registers, has memo
VME A24 or A32 space that is accessible through addresses on the 
VME/VXI data transfer bus.

Message-Based device An intelligent device that implements the defined VXIbus registers a
communication protocols. These devices are able to use Word Serial 
Protocol to communicate with one another through communication 
registers.

MODID A set of 13 signal lines on the VXI backplane that VXI systems use to 
identify which modules are located in which slots in the mainframe.

MQE Multiple Query Error; a type of Word Serial Protocol error. If a Command
sends two Word Serial queries to a Servant without reading the respon
the first query before sending the second query, a MQE is generated.

multitasking The ability of a computer to perform two or more functions simultaneou
without interference from one another. In operating system terms, it is
ability of the operating system to execute multiple applications/proces
by time-sharing the available CPU resources.

N

NI-VXI The National Instruments bus interface software for VME/VXIbus 
systems.

nodes Execution elements of a block diagram consisting of functions, structu
and subVIs.
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nonprivileged access One of the defined types of VMEbus data transfers; indicated by ce
address modifier codes. Each of the defined VMEbus address spaces
defined nonprivileged access mode.

P

peek To read the contents.

pointer A data structure that contains an address or other indication of storag
location.

poke To write a value.

privileged access See supervisory access.

protocol Set of rules or conventions governing the exchange of information betw
computer systems.

Q

query Like a command, causes a device to take some action, but requires a 
response containing data or other information. A command does not 
require a response.

queue A group of items waiting to be acted upon by the computer. The 
arrangement of the items determines their processing priority. Queues
usually accessed in a FIFO fashion.

R

read To get information from any input device or file storage media.

register A high-speed device used in a CPU for temporary storage of small amo
of data or intermediate results during processing.

Register-Based device A Servant-only device that supports only the four basic VXIbus 
configuration registers. Register-Based devices are typically controlled
Message-Based devices via device-dependent register reads and writ

REQF Request False; a VXI Event condition transferred using either VXI sign
or VXI interrupts, indicating that a Servant no longer has a need for serv
LabVIEW VXI VI Reference Manual G-8 © National Instruments Corporation
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REQT Request True; a VXI Event condition transferred using either VXI sign
or VXI interrupts, indicating that a Servant has a need for service.

Resource Manager A Message-Based Commander located at Logical Address 0, which
provides configuration management services such as address map 
configuration, Commander and Servant mappings, and self-test and 
diagnostic management.

response signal Used to report changes in Word Serial communication status betwe
Servant and its Commander.

RM See Resource Manager.

ROAK Release On Acknowledge; a type of VXI interrupter which always 
deasserts its interrupt line in response to an IACK cycle on the VXIbus.
Message-Based VXI interrupters must be ROAK interrupters.

ROR Release On Request; a type of VME bus arbitration where the curren
VMEbus master relinquishes control of the bus only when another bus
master requests the VMEbus.

RORA Release On Register Access; a type of VXI/VME interrupter which do
not deassert its interrupt line in response to an IACK cycle on the VXIb
A device-specific register access is required to remove the interrupt 
condition from the VXIbus. The VXI specification recommends that VX
interrupters be only ROAK interrupters.

RR Read Ready; a bit in the Response register of a Message-Based devic
in Word Serial Protocol indicating that a response to a previously sent qu
is pending.

RRviol Read Ready protocol violation; a type of Word Serial Protocol error. If 
Commander attempts to read a response from the Data Low register w
the device is not Read Ready (does not have a response pending), a 
Ready violation may be generated.

S

sec Seconds

SEMI-SYNC Protocol A one-line, open collector, multiple-device handshake trigger protoco

Servant A device controlled by a Commander.
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Shared Memory Protocol A communications protocol for Message-Based devices that uses a
of memory that is accessible to both a client and a server. The memor
block acts as the medium for the protocol transmission.

short integer Data type of 16 bits, same as word.

signal Any communication between Message-Based devices consisting of a 
to a Signal register. Sending a signal requires that the sending device 
VMEbus master capability.

signed integer n bit pattern, interpreted such that the range is from –2(n – 1) to +2(n – 1) – 1.

slave A functional part of a MXI/VME/VXIbus device that detects data trans
cycles initiated by a VMEbus master and responds to the transfers whe
address specifies one of the device's registers.

SMP See Shared Memory Protocol.

SRQ Service Request

status/ID A value returned during an IACK cycle. In VME, usually an 8-bit value
which is either a status/data value or a vector/ID value used by the 
processor to determine the source. In VXI, a 16-bit value used as a data
lower 8 bits form the VXI logical address of the interrupting device and 
upper 8 bits specify the reason for interrupting.

STST START/STOP trigger protocol; a one-line, multiple-device protocol whi
can be sourced only by the VXI Slot 0 device and sensed by any othe
device on the VXI backplane.

subVI VI used in the block diagram of another VI; comparable to a subroutin

supervisory One of the defined types of VMEbus data transfers; indicated by cert

SYNC Protocol The most basic trigger protocol-simply a pulse of a minimum duration
any one of the trigger lines.

synchronous 
communications

A communications system that follows the command/response cycle 
model. In this model, a device issues a command to another device; th
second device executes the command and then returns a response. 
Synchronous commands are executed in the order they are received.

SYSFAIL* A VMEbus signal that is used by a device to indicate an internal failure
A failed device asserts this line. In VXI, a device that fails also clears i
PASSed bit in its Status register.
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SYSRESET* A VMEbus signal that is used by a device to indicate a system reset o
power-up condition.

system hierarchy The tree structure of the Commander/Servant relationships of all devi
the system at a given time. In the VXIbus structure, each Servant has 
Commander. A Commander can in turn be a Servant to another 
Commander.

T

TIC Trigger Interface Chip; a proprietary National Instruments ASIC used f
direct access to the VXI trigger lines. The TIC contains a 16-bit counte
dual 5-bit tick timer, and a full crosspoint switch.

tick The smallest unit of time as measured by an operating system.

top-level VI VI at the top of the VI hierarchy. This term is used to distinguish the V
from its subVIs.

trigger A condition for starting or stopping clocks.

tristated Defines logic that can have one of three states: low, high, and 
high-impedance.

TTL Transistor-Transistor Logic.

U

UART Universal Asynchronous Receiver Transmitter.

unasserted A signal in its inactive false state.

unsigned integer n bit pattern interpreted such that the range is from 0 to 2n – 1.

UnSupCom Unsupported Command; a type of Word Serial Protocol error. If a 
Commander sends a command or query to a Servant which the Servan
not know how to interpret, an Unsupported Command protocol error is
generated.
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VIC VXI Interactive Control program, a part of the NI-VXI bus interface 
software package. Used to program VXI devices, and develop and de
VXI application programs. Called VICtext when used on text-based 
platforms.

virtual instrument (VI) LabVIEW program; so called because it models the appearance and 
function of a physical instrument.

VME Versa Module Eurocard or IEEE 1014.

VMEbus Class device Also called non-VXIbus or foreign devices when found in VXIbus syste
They lack the configuration registers required to make them VXIbus 
devices. 

VXIbus VMEbus Extensions for Instrumentation.

vxiedit VXI Resource Editor program, a part of the NI-VXI bus interface softwa
package. Used to configure the system, edit the manufacturer name an
numbers, edit the model names of VXI and non-VXI devices in the syst
as well as the system interrupt configuration information, and display t
system configuration information generated by the Resource Manager
Called vxitedit when used on text-based platforms.

W

wire Data path between nodes.

word A data quantity consisting of 16 bits.

Word Serial Protocol The simplest required communication protocol supported by 
Message-Based devices in the VXIbus system. It utilizes the A16 
communication registers to perform 16-bit data transfers using a simp
polling handshake method.

WR Write Ready; a bit in the Response register of a Message-Based device
in Word Serial Protocol indicating the ability for a Servant to receive a 
single command/query written to its Data Low register.
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write Copying data to a storage device.

WRviol Write Ready protocol violation; a type of Word Serial Protocol error. If 
Commander attempts to write a command or query to a Servant that is
Write Ready (already has a command or query pending), a Write Rea
protocol violation may be generated.
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